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Getting Started

Congratulations on the purchase of your new Pocket PC
Phone! This chapter helps you set up your phone, charge
the phone’s batteries, and familiarize yourself with the
different components of your phone.

®" What's in the Box?

Your Pocket PC Phone comes with:

e Extra stylus

e Travel adapter

e Desktop charger with ActiveSync feature
o Batteries

e Ear-microphone

Handstrap
e User’s guide

CD-ROM which contains Microsoft ActiveSync software,
Add-on software and applications, User’s guide in the PDF
format.

In addition, you can obtain the following accessories for
your phone from your local Samsung dealer:

¢ Simple hands-free kit

e Car holder

e Cigarette lighter charger
e |Leather/Plastic Case

| |
Phone
Front View
Camera ——;

Program button 1
(Recording)

Volume buttons —

Dialer/Send

Speaker
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Getting to Know Your Pocket PC
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——Power button
——Backlight button

Touch screen

Navigation/OK

buttons

button

Program button 2 ———

(Calendar)

End button

Program button 3

' (Contacts)

\KT’ bz&ﬁf Microphone
assann

Program button 4
(Internet Explorer)

Program button 5
(Inbox)
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Rear View Description

Power button. Press to turn your Pocket PC
Phone on or off. Press and hold to turn the
phone’s power on or off.

Backlight button. Press to turn the backlight
on or off. Press and hold to force the Pocket PC
Phone in or out of the Sleep mode.

Infrared port for
exchanging data with
other device wirelessly.

Ear-microphone

Battery lock — Jack

Navigation buttons allow you to scroll
through a list.

SNTSUN G

OK button. Press to confirm your selection.

Battery —=——— Expansion slot for an

option SD card

Phone/Send button. Press to open Phone.
In the Phone mode, press to send or answer a
call.

—i— RESET button. Push

this button with the
K\\\;_/\/ stylus to reset your

phone.

End button. In the Phone mode, press to end a
call. Press and hold to turn your phone on or
off.

Programmable application button 2. Default
setting is Calendar.

Stylus holder

Charging/
Communication port

Programmable application button 1. Default
setting is Record. Press to view the list of
Recordings in Notes. Press and hold to record
a message.

Desktop Charger
Programmable application button 4.
Default setting is Internet Explorer.

Programmable application button 3.
Default setting is Contacts.

Battery
compartment to
hold battery only.

Support to hold the
Pocket PC Phone
with battery
attached.

Programmable application button 5.
Phone charge Default setting is Inbox.

indicator

m Battery charge indicator

Volume button. Press to adjust the volume.

A
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Using the Stylus Pen

Your Pocket PC Phone has many of the same functions
as a portable personal computer, but does not have a
keyboard or a mouse. Use the stylus provided with your
phone to access, run, or enter information through the
touch-screen LCD display.

Pull the stylus out of the stylus holder. When you do not
use the stylus, insert it into the stylus holder.

N

Stylus holder

Use the stylus to:

Tap: Softly touch the screen once with the stylus to
select or execute an application or command. Tap works
like a mouse click on a computer.

Drag: Hold the stylus on the screen and drag it across
the screen to select text.

Tap-and-hold: Tap and hold the stylus on an item to
see a list of actions available for that item. Tap the
action you want to perform on the pop-up menu that
appears.

Note: To prevent scratches, do not use an actual pen, pencil
or other sharp objects to tap or write on the screen.
The stylus tip can also be used to press the RESET
button. For details about resetting, see page xx.

Getting Started

== Installing the SIM Card

When you subscribe to a cellular network, you are

provided with a plug-in SIM card loaded with your

subscription details, such as your PIN, any optional
services available and many others.

¢ Keep all miniature SIM cards out of the reach of small
children.

e The SIM card and its contacts can easily be damaged by
scratches or bending, so be careful when handling,
inserting or removing the card.

¢ When installing the SIM card, always make sure that the
phone is switched off before you remove the battery.

Inserting the SIM Card

1. If necessary, remove the battery by referring to
“Removing the Battery” on page xx.

2. Insert and slide the SIM card under the two tabs,
ensuring that the notched corner is the bottom left and
the gold contacts of the card face down into the phone.
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Removing the SIM Card

To remove the SIM card, slide the card out of the holder,

as shown.

Installing the Battery

Installing the Battery

1. Put the battery on the back of the phone.

Getting Started

2. Slide the battery up until it clicks into place.

Make sure that the battery is securely locked before
switching the phone on.

Removing the Battery

1. To remove the battery, press and hold the battery lock
button, with the back of the phone facing you.

2. Slide the battery off the phone, as shown.

Battery lock
button
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Charging Your Pocket PC Phone

With the Travel Adapter

1. Plug the connector of the travel adapter into the bottom
of the phone. Check that the arrow on the connector is
facing toward the front of the phone.

2. Plug the adapter into a standard AC wall outlet.

3. When charging is finished, unplug the adapter from the
power outlet and from the phone by pressing the PUSH
button on the connector and pulling the connector out.

Getting Started

With the Desktop Charger

You can use the desktop charger to charge the phone’s
battery and synchronize your Pocket PC Phone to your

PC. For information about synchronizing your Pocket PC
Phone, see page xx.

To charge the battery with the desktop charger:

1. Connect the travel adapter to the adapter jack on the
back of the desktop charger and plug the travel adapter
into a standard AC outlet.

2. Lift the frame towards the base so that it is at a 45°
angle and cannot move back any further.

Base

Support

A
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3. Select one of the following ways:

Place the entire phone with battery attached into the
desktop charger, bottom first, so that the data
connector is inserted.

Then push the phone backwards into the frame until you
hear a click.

Slide a single battery alone, not attached to the phone,
into the base compartment of the desktop charger; first,
insert the bottom of the battery under the two tabs of
the charger and then push the battery until you hear a
click.

You can charge the phone and the single battery
together.

Getting Started

4. The charge indicators on the front of the charger come
on.

The indicator light shows the status of the battery being
charged.

e Red: the battery is charging.

e Green: the battery is fully charged.

e Orange: the battery is not seated correctly on the
desktop charger or the travel adapter is not plugged in
correctly. Check the battery and the adapter.

Phone charge indicator

Battery charge indicator

5. When the indicator light turns green, remove the phone
or battery from the charger. To remove the phone, first
pull the phone towards you slightly and then lift up.
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Once the battery is charged, you can use the phone in
the desktop charger or out of the charger for all
functions. If you have purchased an extra battery, you
can charge it in the charger while you are using the
phone.

Using Backlight

The backlight button ({it) is located on the right side of
the phone. Simply pressing the backlight button will turn
the backlight on or off.

Pressing and holding the button for approximately 2
seconds will force your Pocket PC Phone in and out of
the Sleep mode.

Low Battery Warning

If the battery gets very low, your Pocket PC Phone
displays a warning message. When this happens, save
any unsaved data you are working on, perform a
synchronization with your PC, then turn off your Pocket
PC Phone. Don't try to restart your Pocket PC Phone
until you have connected to an external power source. If
your Pocket PC Phone shuts down, the backup portion of
your battery will protect your data for about 72 hours.

Saving Battery Power

You can conserve more battery power time by adjusting
Power settings. During standby, the unit turns off so
very little power is being consumed. This helps to
preserve programs and data stored in the RAM.

A lower setting increases the usable battery time. A
higher setting decreases the usable battery time and
allocates it for standby usage.

You can also adjust the Battery setting to conserve
more battery power.

To adjust the Power setting:

1. From the Start menu, tap Settings.
2. In the System tab, tap Power.

3. Put a checkmark on the box and select time setting from
the list. Then tap [o8.

#i¥ | settings Y o437 O

Power

Main battery: Lilon
Batkery power remaining:

o I (0

|| his picture will be updated In the next version.

U OLLET Y PUWEr:

D L;I;I; ?;Fr device if not

0On external power:

D L;I;I; ?;Fr device if not

Adjust backlight settings ko conserve power,

B~
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To adjust the Backlight setting:

1. From the Start menu, tap Settings.
2. In the System tab, tap Backlight.

3. Select the backlight settings.

In the Battery Power tab, select when to use the
backlight on battery power.

Settings Y «¢536 O
Backlight

warning: Using backlight while on battery
power will substantially reduce battery life.

On battery power:
Turn of f backlight if -
device is not used For

D Turn on backlight when a buktan is
pressed or the screen is tapped

EBattery Power | External Power | Erightness |

Adjust power settings to conserve power.

(8

In the External Power tab, select when to use the
backlight on external power.

In the Brightness tab, select the brightness level.

4. Tap [o.
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== Installing ActiveSync

When using Microsoft® ActiveSync®, you can synchronize
information on your desktop computer and/or a Microsoft®
Exchange Server with the information on your Pocket PC
Phone. ActiveSync compares the information on your
Pocket PC Phone with the information on your desktop
computer and/or the server and updates all locations,
keeping you up-to-date with the most recent information.

Note: Using Server ActiveSync®, you can synchronize
information directly with a Microsoft® Exchange Server if
your company is running Microsoft® Mobile Information
Server 2002 or later.

Before you can begin synchronization with your desktop
computer, you must install ActiveSync on your desktop
computer from the supplied CD-ROM.

To install ActiveSync on your desktop computer:

1. Insert the CD-ROM into the CD-ROM drive of your
desktop computer.

2. Follow the instructions on the screen for installing
Microsoft ActiveSync.

For more help, click on the Microsoft Active Help
button during installation.
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3. After installation is complete, the ActiveSync New
Partnership Wizard helps you connect your phone to
your desktop computer, set up a partnership so that you
can synchronize information between your phone and
your desktop computer and/or server, and customize
your synchronization settings.

Your first synchronization process will automatically
begin when you finish using the wizard.

Important: To prevent synchronization problems, select
Synchronize with Microsoft Mobile Information Server
and/or this desktop computer only if you are certain that your
company is running Microsoft Mobile Information Server 2002 or
later, and you know the server name. Otherwise, select
Synchronize with this desktop computer instead. For more
information, contact your network administrator or service
provider.

After the first synchronization, take a look at Calendar,
Contacts, and Tasks on your Pocket PC Phone. You will
notice that your information has been copied to the phone.
Disconnect the phone from the desktop computer and you
are ready to go!

For more information about ActiveSync, see Chapter 4,
“Synchronizing Information.”
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This chapter explains basic information about using your
phone, such as customizing your phone and using on-line
help.

=% Using the Today Screen

You will see the Today screen when you first turn on your
Pocket PC Phone. You can also display it by tapping
Start - Today.

On the Today screen, you can see important information
for the day, at a glance.
Tap to switch to

a brogram —— Tap to turn on/off the
prog ' | phone’s power.
change time ( Friday, August 29, 2003 or mute all sounds.
Ta?)nt% (él)?)t;'\ !—![ Tap here to set awner infarmation
an item. —
Tap to view
your day at

a glance.

Tap to create a new item.
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Following are some of the status icons you may see:

Status Icon

Description

<

Turns all sounds on and off.

a

Main battery is low.

i

Main battery is very low.

il

Connection is active.

&

Synchronization is beginning or ending.

2 Synchronization is occurring.
il

Y Notification that one or more instant
il messages have been received.
Notification that one or more e-mail/

SMS/MMS messages have been received.

.q

Shows the connection to your mobile
phone service provider is on and the
strength of the signal.

5

Indicates your phone is switched off.
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Creating New Information from the Today
Screen

From the Today screen, you can create new information,
including:

e Appointment

e Contact

e E-mail message

e Excel workbook

¢ Note

e Task

e Word document

For more information on creating these items, see the
appropriate instructions for each task in this guide. For

example, to create a new appointment, see “Calendar:
Scheduling Appointments and Meetings” on page xx.

On the Today screen, tap New on the bottom of the
screen, and then tap the menu you want to create a
new item.

EI Tap here to set owner information

Mo upcoming appoinkments

Appointment
Contack

E-mail Message
Excel Workbook
Note
Task
Word Document
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Changing Information from the Today
Screen

From the Today screen, you can change information,
including;

e owner information

e upcoming appointments

e unread and unsent messages

e tasks that need to be completed

e unread MMS messages

For more information on changing these items, see the
appropriate instructions for each task in this guide.

1. On the Today screen, tap the information you want to
change.

2. Enter or change the information.

3. Tap to save changes and return to the Today screen.
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Customizing the Today Screen

You can customize the Today screen in the following
ways: change the background picture, select the
information you want displayed and in what order, and
further customize to show future appointments.

To change the background:

1. From the Start menu, tap Settings > Personal
Today.

2. In the Appearance tab, select the desired theme for
the background. To use your own background, select
Use this picture as the background and tap the
Browse button to locate the file you want.

£ | settings Y «¢540 D

Today

To customize the Today screen, tap one of
the Following themes and tap QK.

Bliss
Fire:

I:‘ Use this picture as the background

Browse

Appearance | Ikems |

E|A

3. Choose a folder and type.

4. Tap the picture you want to use and then tap .

A
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To customize the information you want displayed:

1. From the Start menu, tap Settings ~ Personal
Today.

2. In the Items tab:
e uncheck a box to remove its information.

e select an item and tap Move Up or Move Down to
change its position.

e choose to select or deselect Display Today screen if
device is not used for, and then select a number of
hours from the box below.

/5% |settings Y @51 (D

Today

Checked iterms appear on the Today screen.

v | Owiner Info

Calendar
Inbox
Tasks
MG

Display Today screen if device is nok used

For hours

Appearance | Items |

The Basics

== Customizing Your Phone

You can customize the Pocket PC Phone settings to suit
the way you work.

Setting Time and Date

When you turn on your Pocket PC Phone for the first

time, you are guided through setting the time. Set the
time again if:

e the battery completely discharges.
¢ you perform a hard reset of your Pocket PC Phone.

Note: You can also change the time on the Today screen by
tapping the clock icon on the top of the screen.

1. From the Start menu, tap Settings.

ey Y «£12:01 9
Buttons Input Menus
= &
Owner Password Phone

Information

2 @

Sounds & Today
Notifications

Personal | Swyskem | Conneckions |

E|A

A
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2. In the System tab, tap Clock, and then Home.

3. Tap the time-zone down arrow to select your location
and time zone.

Y 4327 D

GMT-8 Pacific Us -

32752 PM : -
5 [22{2003 M

() Visiting
GMT+1 Paris,Madrid +

< 12:27:52 AM : -

S /232003 M

Time: | Alarms |

E|A

4. Tap the hour, minutes, or seconds to select the time you
want to adjust, then tap the up or down arrow to change

hour, minute, or second.

Or, move the hands of the clock with the stylus to adjust

the time.
Tap AM or PM to change the time to PM or AM.
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5. Tap the date down arrow to see a calendar.

‘.{3;}" Settings Y D542 QB

Clock

12, GMT-G Pacific U5 ~
o 5 _542z4PM : -
/\ J 8 /202003 -

6 Kl August 2003
O visiting 21 T W T F 5

27 28 20 20 31 1 2
2 4585 7 8 0
10 11 12 13 14 15 16
_—*""|17 13 13 20 21 22 23
: |24 25 26 27 25 EER e
311 2 3 4 5 6
Today: 8/29/03
]

Time | &larr

E|A

6. Tap the left or right arrow on the top of the calendar to
move backwards or forwards through the calendar.

7. Tap a day to select the date.

8. Tap 8.

9. Tap Yes to save your clock settings.

You can also set the time for a location you're visiting by
selecting Visiting on the Clock setting.
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Entering Owner Information

The owners information identifies the owner or user of
the Pocket PC Phone. Name, company, address, phone
number, e-mail address, and note information fields are
available.

1. From the Start menu, tap Settings.

2. In the Personal tab, tap Owner Information.

#17 |settings Y o¢324 (D

Owner Information

Mame:

Cormnpany:

Address:

Telephone:

E-rnail:

D Shows information when
device is turned on

Identification | MNaokes |

;[

3. Tap the Name box. Input panel appears.

4. Enter name. For details on entering characters, see
page Xx.

5. Tap the other desired information boxes and enter the
information.
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6. If you want to attach notes, tap the Notes tab and
enter notes.

7. When you are finished entering all the desired
information, tap [o8).

Note: When you turn on your device for the first time, you
can also enter the owner information by tapping on
Tap here to set owner information.

Changing a Security Password

The Password option allows you to enable or disable a
password.

When a password is configured, there is a Prompt if
device unused for option that allows a length of time
range from 0 minute to 24 hours. When this option is
set, you can continue to use your device until the screen
turns off due to inactivity. If your device is inactive for a
greater amount of time than specified in the unused
setting, a password must be entered when you turn the
device back on.

To set the password:

1. From the Start menu, tap Settings > Personal
Password.

2. Tap the password option you want and enter the
password.

3. If desired, set the "Prompt if device unused for” time
by tapping the drop down arrow and selecting the
proper time increment.
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Setting Sounds & Notification

Your Pocket PC Phone reminds you in various ways when
you have something to do or receive a message. For
example, if you've set up an appointment in Calendar,
or an alarm in Clock, you’ll be notified in any of the
following ways:

e A message box appears on the screen.

¢ A sound, which you can specify, is played.
¢ A light flashes on your Pocket PC Phone.
e Your Pocket PC Phone vibrates.

To choose reminder types and sounds:

1. From the Start menu, tap Settings > Sounds &
Notifications.

2. Choose the options. The options you choose here apply
throughout the phone. Tap to save the setting.

1¥|settings Y 4t3zs O

Sounds & Notifications

System volume

Silent .:U Loud
T

Enable sounds for
Events {warnings, system events)
Programs
Motifications (alarms, reminders)
Screen baps
() seft () Loud
Hardware buttons

() seft () Loud

Yolume | Matifications |

E|A
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Realigning the Screen

When you turn on your Pocket PC Phone for the first
time, you are guided through the alignment process.
Realign your screen if:

e your Pocket PC Phone does not respond accurately to
your screen taps.

e you perform a hard reset of your Pocket PC Phone.
1. From the Start menu, tap Settings.
2. In the System tab, tap Screen.

3. Tap the Align Screen button to begin the realignment
process.

Screen

Align Screen

Adjust the touch screen iF your device is not
responding accurately to screen taps, To do so,
tap the Align Screen button or press the Action
hardware button,

Align Screen

ClearType

ClearType smoothes the edges of screen fonts
for many programs,

[] Enable ClearType

Mote: You must soft reset your device for
changes to take effect

Adjust nput options to improve speed and
aCCUFACY,

B~

4. Tap the cross-hair object at each location to realign the
screen. Be precise when you tap the cross-hair object.

A

5. Tap 8.
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®Z Using an Option SD Card

Your Pocket PC Phone has an expansion slot compatible
with a range of SD and MMC Memory cards, which are
primarily used to backup or transfer files and data.

To insert or remove a memory card:

1. Push the memory card into the slot until it clicks into
place. The card is secure when it is not protruding from
the base.

2. To remove the card, push it in and then release, letting
the card spring out.

Note: When you receive your Pocket PC Phone, there will be a
piece of plastic in the slot; remove as described in the
step 2 above.
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Adding and Removing Programs

Programs added to your Pocket PC Phone at the factory
are stored in ROM (Read Only Memory). You cannot
remove this software, and you’ll never accidentally lose
ROM contents. ROM programs can be updated using
special installation programs with a *.xip extension. All
other programs and data files added to your Pocket PC
Phone after factory installation is stored in RAM
(Random Access Memory).

You can install any program created for your Pocket PC
Phone, as long as your device has enough memory. The
most popular place to find software for your device is on
the Pocket PC Web site (http://www.microsoft.com/
mobile/pocketpc).

Adding Programs Using ActiveSync

You'll need to download the appropriate software for
your Pocket PC Phone to your PC before installing it on
your phone.

1. Determine what your Pocket PC Phone and processor
type is so that you know which version of the software
to install.

2. From the Start menu, tap Settings > System
About.

3. In the Version tab, make a note of the information in
Processor.

A



The Basics

. Download the program to your PC (or insert the CD or

disk that contains the program into your PC). You may

see a single *.xip, *.exe, or *.zip file, a Setup.exe file,

or several versions of files for different device types and
processors. Be sure to select the program designed for
the Pocket PC and your unit processor type.

. Read any installation instructions, Read Me files, or

documentation that comes with the program. Many
programs provide special installation instructions.

. Connect your Pocket PC Phone to your PC.

. Double click the *.exe file.

If the file is an installer, the installation wizard will
begin. Follow the instructions on the screen. Once the
software has been installed on your PC, the installer will
automatically transfer the software to your Pocket PC
Phone.

If the file is not an installer, you will see an error
message stating that the program is valid but it is
designed for a different type of PC. You will need to
move this file to your phone. If you cannot find any
installation instructions for the program in the Read Me
file or documentation, use ActiveSync Explore to copy
the program file to the Program Files folder on your
phone. For more information on copying files using
ActiveSync, see ActiveSync Help.

. Once installation is complete, tap Start ~ Programs,

and then tap the program icon to switch to it.
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Adding a Program Directly from the
Internet

1.

Determine what your Pocket PC Phone and processor
type is so that you know which version of the software
to install.

. From the Start menu, tap Settings » System

About.

. In the Version tab, make a note of the information in

Processor.

. Download the program to your Pocket PC Phone straight

from the Internet using Internet Explorer on your Pocket
PC Phone. You may see a single *.xip, *.exe, or *.zip
file, a setup.exe file, or several versions of files for
different device types and processors. Be sure to select
the program designed for the Pocket PC and your unit
processor type.

. Read any installation instructions, Read Me files, or

documentation that comes with the program. Many
programs provide special installation instructions.

. Tap the file, such as a *.xip or *.exe file. The installation

wizard will begin. Follow the directions on the screen.
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Adding a Program to the Start Menu
1. From the Start menu, tap Settings ~ Menus.

2. Select the check box for the program you want to add to
the Start menu.

If you do not see the program listed, you can either use
File Explorer on your unit to move the program to the
Start Menu folder, or use ActiveSync on the PC to
create a shortcut to the program and place the shortcut
in the Start Menu folder.

Removing Programs
1. From the Start menu, tap Settings.
2. In the System tab, tap Remove Programs.

3. Select the program you want to delete, and then tap the
Remove button.

If the program does not appear in the list of installed
programs, use your device to locate the program, tap
and hold the program, and then tap Delete on the pop-
up menu.

The Basics

Managing Memory

The Memory on your Pocket PC Phone is shared between
storage memory and program memory. Storage
memory is used to store the information you create and
the programs you install. Program memory is used to
run programs on your Pocket PC Phone.

Pocket PC Phone automatically manages the allocation
between storage and program memory.

To view memory allocation and availability:

1. From the Start menu, tap Settings.
2. In the System tab, tap Memory.
3. Adjust the memory by moving the slider.

Settings Y o437 O

Memory

Memory is managed automatically, To
termporarily adjust the allocation of storage
and program memory, mave the slider,

Tokal main memory 27.89 MB
Storage Program

[ I R ' ' e [

Allocated: 11,63 MB  allocated: 16,26 MB
Inuse: 4.03 MB Inuse: 8.01 MB
Free: 7.60 MB Free: 225 MB

Main | Running Programs

Eemove programs to free storage memory.

Eind large files using storage memory,

B~

4. Tap [ to save the setting.
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®- Resetting the Pocket PC Phone

You can perform a soft reset or a full reset — a soft reset
restarts your Pocket PC Phone and a full reset switches
the battery off. The result of a soft reset is that some
data may be lost in programs that are open, however,
the result of cutting power (a full reset) is to wipe out all
the data and new programs you have added, and return
the device to its factory setting - i.e. it will only have
the software that was present when you bought it.

It is important not to think about a full reset restarting,
shutting down or even improperly switching off your
desktop, but rather like a complete crash requiring you
to have to wipe out your OS. The importance of backing
up data to an SD card or your computer cannot be
stressed enough - in the event you have to perform a
full reset your data will not be lost.

Performing a Soft Reset

If your Pocket PC Phone responds slowly, stops
responding or freezes, try a soft reset. A soft reset
causes the Pocket PC Phone to restart and re-adjust
memory allocation. Unsaved data in open windows may
be lost.

To perform a soft reset:

1. Unscrew the stylus.

The Basics

2. Press the Reset button in the hole with the end of the
top-half of your stylus.

Perform a Full Reset

Note: A full device reset clears memory, deletes all data and
restores the Pocket PC Phone to its default settings.
Programs installed at the factory remain, while data
you have created and programs you have installed are
erased.

How to do???
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Connection Settings

Connection settings enable you to set up connections so
you can connect to the Internet or your corporate
network.

Connect to the Internet or Your Network

To send and receive e-mail with Inbox and view Web
sites with Internet Explorer, you must set up a remote
connection using a modem card or an Ethernet/LAN
card.

To disconnect, remove the card from your Pocket PC
Phone.

Using a Modem Card

To connect to the Internet with a modem card, you need
a phone line, a dial-up Internet Service Provider, and an
optional Single-Slot or Dual-Slot PC Card Expansion
Pack, Expansion Pack Plus, or CompactFlash (CF) Card
Expansion Pack.

Note: Insert your modem card before trying to set up a
modem connection.

The Basics

1. Insert your modem card into the option card slot in your

Pocket PC Phone.

Most of the popular modem card drivers are included on
your Pocket PC, so your modem card should be
recognized.

If your modem card is not recognized, follow your
modem manufacturer’s instructions to install the
modem card driver on your computer.

2. From the Start menu, tap Settings.
3. Tap the Connections tab.

4. Tap Connections.

/75 | settings Y «f441 (D

Connections
Wwhen needed, automatically connect
to The Internet using these settings:

-

% when needed, automatically connect:
to Work using these settings:

[y wiark Netwark -

E& My network card connects ta:
|W0rk v|

Conneckions | Dialing Lacations |

E|A

5. Make sure your internet setting is selected.

6. Tap the Modify button.
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7. Tap New.

8. Enter a name for the connection, select the modem
type, then select the correct baud rate for that modem.

9. If you need to enter the TCP/IP settings, tap Advanced,
then tap TCP/IP.

10. Select Use specific IP address.

Advanced

@ Use server-assigned IP address
O Use specific IP address

[] use slip
Lse software compression
Use IP header compression

Pork Settings | TCPIIP | Mame Servers |

1231[2[3[4]s[e]7[8]09]0]-[=[4
Taba[wler[t[y[ui[o[p|[]]
caPla[s[d[fla[h[i[k[I];["]
shift{z[x[c[v[b[nm][, [. [/[+
culada* [\ ] [+[1]<]=
=8

11. Enter your IP address.

12. Tap [o.

13. Tap Next.

14. Enter the phone number for your Internet service
provider, then tap Finish to set up the modem
connection.

15. Tap [o] to save the setting.
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Using an Ethernet/LAN Card

To connect to the Internet or to your network using an
Ethernet/LAN card, you need:

e a computer with an Ethernet card.

e a computer set up for TCP/IP and a client for Microsoft
Networks.

e an Ethernet hub or a crossover cable to plug in your
Pocket PC.

¢ a Single-Slot or Dual-Slot PC Card Expansion Pack or a
CompactFlash (CF) Card Expansion Pack.

Insert your Ethernet/LAN card into your Pocket PC
Phone.

If your Ethernet/LAN card is not recognized, follow your
Ethernet card manufacturer’s instructions to install the
Ethernet card driver.

Do one of the following:

e If you are using a DHCP server, the network settings
should be entered for you automatically.

e If you are not using a DHCP server, enter your network
settings.

1. From the Start menu, tap Setting.

2. Tap the Connections tab, then tap Network
Adapters.
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3. Tap the name of your Ethernet driver, then tap the |
Properties button.

Using Online Help

13 |settings Y <730
AsyncMacl NDISWAN Adapter

Your Pocket PC Phone is supported by additional
information when using the unit.

() Use sarver-assigned IP address
() Use specific IP address For information

IP address: l:l on:

See this source:

N

o

N

2]

1P Address | Marme Servers

Programs on your
Pocket PC Phone

The User’s Guide and on-line Help.
To view Help, tap Start and then
Help.

12301]2[3]4[5][6][7[8]o[0]-[=]a« — -
Tab||l3|||w||9||l'||t||¥||u|| || ||p||[||] Additional The supplied CD-ROM.
CAPlals|d|T]0|h|] rograms that can
shiftl s erclvlblnlml L L1 Eeigr]lstalledon our
cHlah] " |\ |¢|1|«|» y

=g Pocket PC Phone

. Tap the Name Servers tab.

. Enter the server information.

Tap [6§ to save the server information.

Tap to save the network settings.

. Tap [ to exit.

Connecting to and
synchronizing with
aPC

The User’s Guide or ActiveSync
Help on your PC. To view Help,
click Help and then Microsoft
ActiveSync Help.

Last-minute
updates and
detailed technical
information

The Read Me files, located in the
Microsoft ActiveSync folder on
the PC and on the Pocket PC
Companion CD.

Up-to-date
information on your
Pocket PC Phone

http://www.microsoft.com/mobile/
pocketpc.
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Entering Information

You have several options for entering new information:

e Use the input panel to enter typed text, either by using
the on-screen keyboard or other input method.

e Write directly on the screen.
e Draw pictures on the screen.

e Speak into your Pocket PC Phone’s microphone to record
a message.

e Use Microsoft ActiveSync to synchronize or copy
information from your PC to your Pocket PC Phone. For
more information on ActiveSync, see ActiveSync Help on
your PC.

Notes Y £ 442 (N
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123[1]2[3[4][5[6][7[B]9]0]- =]«
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ctfai] - A ] [LTt]<]~ Tap it to
New Edit Tools (= [+ — change the
‘ input method.

Input Panel button

Entering Text Using the Input Panel

Entering Information

¢ Use the input panel to enter information in any program
on your Pocket PC Phone. You can either type using the
on-screen keyboard or write using Block Recognizer,
Letter Recognizer, or Transcriber. In either case, the
characters appear as typed text on the screen.

e To show or hide the input panel, tap the Input Panel
button (Eg) on the command bar. Tap the arrow next to
the Input Panel button to change the input method.

When you use the input panel, your Pocket PC Phone
anticipates the word you are typing or writing and
displays it above the input panel. When you tap the
displayed word, it is inserted into your text at the
insertion point. The more you use your Pocket PC Phone,
the more words it learns to anticipate.

Y «£10:34

Maonthly rmes -

meeting i Tap here if this is
123[1[2[3[4[s5]|6[7[8[9]0]-[=]4 the right word.

Tab[a[wle[r[t]y[uli[o[p[[[]
capla[s[d[fla[h[j[k[I];]"]
shift[z[x[c[v[b[n[m][,[.[/]+
cufai] " [\ ] [+[1]<]~-
New Edit Tools [ 7 =B



Entering Information

Typing with the On-screen Keyboard

You can enter typed text directly on the screen by

tapping letters, numbers, and symbols on the keyboard.

Note: To see the symbols, tap the 123 or Shift key.

1. From any application, tap the up arrow next to the
Input Panel button ().

2. Tap Keyboard to display a keyboard on the screen.

T o< 444 O
. =
Options...
1231[2]3]4]5 Block Recognizer )
Tabla[wlelr[1, o Select an input

CAPla|s|d|f
Tap to type a Shift|| z|| x|| c|| \,l Letter Recognizer method.

single uppercase [:t||éij| - | \ | Transcriber
letter or symbol.  New Edit Teols = 2 ]

3. Tap a letter, symbol, or number to enter information.

To type a single uppercase letter, tap the Shift key. To
tap multiple uppercase letters, tap the CAP key.

If you want to use larger keys, tap the up arrow next to
], tap Options, select Keyboard in Input Method,
and then select Large Keys.
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Writing with the Stylus and Letter
Recognizer

Write letters, numbers, and symbols on the screen using
the stylus and Letter Recognizer. Create words and
sentences by writing in upper case (ABC), lower case
(abc), and symbols (123) in specific areas.

1. From any application, tap the up arrow next to the
Input Panel button (B ).

2. Tap Letter Recognizer to see a writing area.

3. Write a letter or symbol between the dashed line and
baseline for Letter Recognizer to work effectively.

T o< 445 O
o El
ABC T abc | 177 «
_________________ Rl e
‘_I SPC
, . 7 & Tap it to view
New Edit Tools = 27 Z 4] specific

instructions.

Write a letter between the hatchmarks labeled ABC to
type text in upper case.

A



Entering Information

Write a letter between the hatchmarks labeled abc to
type text in lower case.

Write a number or symbol between the hatchmarks
labeled 123 to type symbols.

4. What you write on the screen will be converted to text.

Writing with the Stylus and Block
Recognizer

Write letters, numbers, and symbols using the stylus
and the Block Recognizer. Create words and sentences
by writing letters and numbers in specific areas.

1. From any application, tap the up arrow next to the
Input Panel button (B).

2. Tap Block Recognizer to see a writing area.

Y oof 444 (0

-

gl B
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3. Write a word, letter, or symbol between the hatchmarks.

Write a letter between the hatchmarks labeled abc to
type text.

Write a number or symbol between the hatchmarks
labeled 123 to type a number or symbol.

What you write on the screen will be converted to text.

Writing with the Stylus and Transcriber

With Transcriber, you can write anywhere on the screen
using the stylus just as you would on paper. Unlike
Letter Recognizer, you can write a sentence. Pause and
let Transcriber change the written characters to typed
characters.

1. From any application, tap the up arrow next to the
Input Panel button ().

2. Tap Transcriber.

3. Write anywhere on the screen. What you write on the
screen will be converted to text.

Notes .:'_! Y o843

I Tap it to view specific
+ B o @ | 2 1= —instructions on using
New Edit Tools B 2 Transcriber.
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4. If you want to punctuate in Transcriber, tap the
keyboard on the toolbar.

e 7o O

-

# -~ ||+
B

H= (A
h
A

5. Tap to hide the keyboard.

To see how to write a letter in Transcriber:
1. Tap “a” on the toolbar.

2. In the screen that appears, select the letter you want to
learn about, and then tap on one of the examples given
above.

.;‘z;j" Letter Shapes Y % 10:55 @

Tap on the shapes above for a demo

T witite this ‘A"

@ often (CiRaraly (O Mewer .
BECDEFGHI JK LMNOPQRSTU\I'iCIICk on a letter for a
WRYZ12345678090 |@#§%"ar demonstration.

([{-+ = .27} | £10®
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Selecting Typed Text

If you want to edit or format typed text, you must select
it first.

1. Drag the stylus across the text you want to select.

Cut

Copy E

Paste

Clear —

Recognize

Alternates...
1231[2[3[4[5][6][7][8]9[0]- [=]+
abla[wle[rt]y[ulifo[p]|[]
capla[s[d[rla[h[i[k[I]:]"]
shiftl 2 [x[c[v[b[n[m[, [.[/]
ctfai] J\] Lt]<]>
New Edit Tools = =18

2. You can cut, copy, and paste text by tapping and holding
the selected words and then tapping an editing
command on the pop-up menu, or by tapping the
command on the Edit menu.

Note: To change word suggestion options, such as the
number of words suggested at one time, from the
Start menu, tap Settings —~ Personal ~ Input and
then the Word Completion tab.

Editing Text

Each input program provides cursor keys to move

through text and a backspace key so that you can

correct spelling, grammar, or insert additional

information. A
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Alternatively, you can use your stylus to make an insert.
After you have made an insert, you can use any of the
input methods described above to add additional text at
the insertion point.

=% Writing on the Screen

In any program that accepts writing, such as the Notes
program, and in the Notes tab in Calendar, Contacts,
and Tasks, you can use your stylus to write directly on
the screen. Write the way you do on paper. You can edit
and format what you’ve written and convert the
information to text at a later time.

Writing on the Screen

1. Tap the Pen button (ﬁ) to switch to the Writing mode.
This action displays lines on the screen to help you
write.

Y oz 1:51

-

e N
/eST

= Tap to switch
New Edit Tools @%@!‘ to the Writing
mode.
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Note: Some programs that accept writing may not have the
Pen button. See the documentation for that program
to find out how to switch to the Writing mode.

2. Tap Tools and then Recognize.

3. If you want to convert only certain words, deselect the
Pen button and select the word. Then, select the Pen
button again and tap Recognize on the Tools menu.
Or, tap and hold the selected words and then tap
Recognize on the pop-up menu. If a word is not
recognized, it is left as writing.

¥ [Notes Y i 5:58 (O
N

Turw

Notes Y i 5:58 (O
K

7y 46_%—
[2EPORT
TKr]
LY
report

New Edit Tools & E|‘ New Edit Tools E|A
To select the text, Select the Pen button and
deselect the Pen button tap Recognize on the
and then drag your stylus Tools menu. The writing is
over the word to be turned into text.

recognized.

A



Entering Information

4. If the conversion is incorrect, you can select different
words from a list of alternates or return to the original
writing. To do so, tap and hold the incorrect word (tap
one word at a time). On the pop-up menu, tap
Alternates.

A menu with a list of alternate words appears. Tap the
word you want to use, or tap the writing at the top of
the menu to return to the original writing.

(Q@PD\/ﬂL S Tap to return to your
original writing.
Report — ___ Or, tap the word you
| rewer _— want to use.
Repost
Repoit
~ | Repozt [
Repozl
~ | Repozi [
New Edit Tools B

Tips for Getting Good Recognition

o Write neatly.

o Write on the lines and draw descanters below the line.
Write the cross of the “t” and apostrophes below the top
line so that they are not confused with the word above.
Write periods and commas above the line.

e For better recognition, try increasing the zoom level to
300% using the Tools menu.

Entering Information

e Write the letters of a word closely and leave big gaps
between words so that the Pocket PC Phone can easily
tell where words begin and end.

Hyphenated words, foreign words that use special
characters such as accents, and some punctuation
cannot be converted.

If you add writing to a word to change it (such as
changing a “3” to an “8"”) after you attempt to recognize
the word, the writing you add will not be included if you
attempt to recognize the writing again.

Selecting Writing

If you want to edit or format writing, you must select it
first.

1. Tap and hold the stylus next to the text you want to
select until the insertion point appears.

2. Without lifting, drag the stylus across the text you want
to select.

Y 451136 N
Phone

Enjoy your | aeeg=ig i
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If you accidentally write on the screen, tap Edit, then
Undo Typing and try again. You can also select text by
tapping the Pen button to deselect it and then dragging
the stylus across the screen.

You can cut, copy, and paste written text in the same
way you work with typed text: tap and hold the selected
words and then tap an editing command on the pop-up
menu, or tap the command on the Edit menu.

Drawing on the Screen

You can draw on the screen in the same way that you
write on the screen. The difference between writing and
drawing on the screen is how you select items and how
they can be edited. For example, selected drawings can
be resized, while writing cannot.

Creating a Drawing

1. Cross three ruled lines on your first stroke. A drawing
box appears.

2. Subsequent strokes in or touching the drawing box
become part of the drawing. Drawings that do not cross
three ruled lines will be treated as writing.

Entering Information
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Selecting a Drawing

If you want to edit or format a drawing, you must select
it first.

1. Tap and hold the stylus on the drawing until the
selection handle appears. To select multiple drawings,
deselect the Pen button and then drag to select the
drawings you want.

2. You can cut, copy, and paste selected drawings by
tapping and holding the selected drawing and then
tapping an editing command on the pop-up menu, or by
tapping the command on the Edit menu. To resize a
drawing, make sure the Pen button is not selected, and

drag a selection handle.
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Creating a Recording

¥ a0 @ 1. Hold your Pocket PC Phone’s microphone near your
= mouth or other source of sound.
_ 2. From the Start menu, tap Notes.
Copy 3. Tap and # to make your recording.
E;s: N e Y o 4:04 (D
Recognize | Indicates an
Alternates... 3 embedded recording.
New Edit Tools & E|A Quote
from Adam
Note: You may want to change the zoom level so that you can
more easily work on or view your drawing. Tap Tools Tap to begin
and then a zoom level. \ *  recording.
o n]) [ |m]u

Tap to show or hide
the Recording toolbar.

New Edit Tools |é| =l

Recording a Message
4. Tap @ to stop recording. The new recording appears in
In any program where you can write or draw on the the note list or as an embedded icon.
screen, you can also quickly capture thoughts,
reminders, and phone numbers by recording a message.
In Calendar, Tasks, and Contacts, you can include a
recording in the Notes tab. In the Notes program, you
can either create a stand-alone recording or include a
recording in a written note. If you want to include the
recording in a note, open the note first. In the Inbox
program, you can add a recording to an e-mail
message.
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Using My Text

When using Inbox or MSN Messenger, use My Text to
quickly insert preset or frequently used messages into
the text entry area. To insert a message, tap My Text
and tap a message.

To edit a My Text message, tap Edit and then tap Edit
My Text Messages. Select the message you wish to edit
and make desired changes.

Inbox Y o= 9:44 @

My Text Messages

Tap a message, then edit below,
Ve Tap to select a pre
MO, | written message.

I can't talk right o, —
'l be right there.
I'm running late. —
Where are you?

Hi. -
[vesl |
123[1[2[3[4[s[6[7[8]9]0]- =]«
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This chapter introduces basic concepts and features of
Microsoft® ActiveSync®, and explains how to set up
Server ActiveSync®, how to synchronize remotely, and
how to create a synchronization schedule. This chapter
also gives an overview of the different types of
Microsoft® Outlook® information you can synchronize.

For more information about ActiveSync, see ActiveSync
Help on your desktop computer.

=: Using ActiveSync

ActiveSync compares the information on your Pocket PC
Phone with the information on your desktop computer
and/or the server and updates all locations with the
most recent information. With ActiveSync, you can:

e keep your Outlook information up-to-date by
synchronizing your Pocket PC Phone with your desktop
computer.

e choose to synchronize Inbox, Calendar, and Contacts with
a server so that you have the latest information, even
when your desktop computer is turned off.

e copy (rather than synchronize) files between your phone
and your desktop computer.

e control when synchronization occurs by selecting a
synchronization schedule.

e select which information types are synchronized and
control how much information is synchronized. For
example, you can choose how many weeks of past
appointments to synchronize.

A
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Note: Using Server ActiveSync, you can synchronize information
directly with a Microsoft Exchange Server if your company
is running Microsoft® Mobile Information Server 2002 or
later.

Installing ActiveSync

Before you begin synchronization, install ActiveSync on
your desktop computer. For further information about
installing ActiveSync, see page XX.

Creating a Partnership

After the installation is complete, the New Partnership
Wizard helps you set up a partnership between your
Pocket PC Phone and your desktop computer and/or a
server so that you can start synchronizing information
and customizing your synchronization settings. Your
first synchronization process will automatically begin
when you finish using the wizard. After the first
synchronization, you will notice that your Outlook
information now appears on your Pocket PC Phone.

Warning: To prevent synchronization problems, select
Synchronize with Microsoft Mobile Information Server
and/or this desktop computer in the New Partnership Wizard
only if you are certain that your company is running Microsoft
Mobile Information Server 2002 or later and you know the server
name. Otherwise, select Synchronize with this desktop
computer. For more information, contact your network
administrator or service provider.

Synchronizing Information

Connection status
Tap to connect and
synchronize.

Tap to stop
synchronization.

|| his picture will be updated In the next version.

SYHILINUINEE PALE L ] view
Lash Syres H2H01 1052 M synchronization
status.

Tap to synchronize via IR or change
synchronization settings.

Setting Up Server ActiveSync

Before you can begin to synchronize information with a
server, you may need to request server configuration
information, such as your user name, password, and the
name of the Microsoft Mobile Information Server, either
from your service provider or from your corporate
network administrator. This configuration information
may have already been set up on your Pocket PC Phone,
or you may have already been given this information.

A
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To set up Server ActiveSync:

1. On the Today screen, press the Programs soft key,
select ActiveSync, and then press the OK button.

2. Press the Menu soft key, select Options, and then
press the OK button.

3. Select Connection, and press the OK button.

4. Under Username, enter your Microsoft Exchange user
name.

5. Under Password, enter your Microsoft Exchange
password.

6. Under Domain, enter the domain name for your
Microsoft Exchange Server (if required).

7. Select Save password if you want your Pocket PC
Phone to remember your password so that you need not
enter it repeatedly.

8. In Server name, enter the name of the Microsoft
Mobile Information Server to which you want to connect
to.

9. Press the Done soft key twice.

10. To begin synchronizing with the server, press the Sync
soft key.

Note: You can also set up a connection to synchronize remotely
with a server when you first create a partnership between
your phone and desktop computer.

Synchronizing Information

To stop certain information types from synchronizing
with a server:

You can stop synchronizing an information type with a
server on your Pocket PC Phone. However, to change to
synchronizing that information type with your desktop
computer instead, you will need to change the
synchronization settings on the desktop computer. For
more information about synchronization, see ActiveSync
Help on the desktop computer.

1. On the Today screen, press the Programs soft key,
select ActiveSync, and then press the OK button.

2. Press the Menu soft key, select Options, and then select
the information type that you no longer want to
synchronize with a server, such as Calendar, Contacts,
or Inbox.

3. Clear the check box next to the information type that
you no longer want to synchronize with a server, and
press the Done soft key.

Synchronizing Remotely

You can synchronize remotely with your desktop computer,
or with a server, if you have set up Server ActiveSync.

To synchronize remotely with a desktop computer:
1. From the Start menu, tap ActiveSync.

2. Tap Tools on the bottom and select Options.

3. In the PC tab, select the Include PC when
synchronizing remotely and connect to checkbox and
select the appropriate computer name.
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4. Tap [oK.

5. To start synchronization, press the Sync button.

Note: To synchronize remotely with a desktop computer, it must
be turned on.

To synchronize remotely with a server:

1. From the Start menu, tap ActiveSync.
2. Tap Tools on the bottom, and select Options.
3. Tap the Server tab.

4. Select the checkbox of the information type to be
synchronized with the server.

5. Tap [o8.

6. To start synchronization, press the Sync button.

Creating a Server Synchronization Schedule

You can create a server synchronization schedule so that
your information is automatically synchronized with the
server at the time intervals that you specify.

To create a Schedule to synchronize with a server
when your phone is connected to a desktop
computer:

1. From the Start menu, tap ActiveSync.

2. Tap Tools on the bottom, and select Options.

Synchronizing Information

3. Tap the Schedule tab.

4. Select the when connected to my PC, synchronize
with the server every check box, and select a length of
time.

5. Tap [H.
6. To start synchronization, press the Sync button.

To creating a schedule to synchronize with a server
when your phone is not connected to a desktop
computer (synchronize wirelessly):

1. From the Start menu, tap ActiveSync.

2. Tap Tools on the bottom, and select Options.

3. Tap the Schedule tab.

4. Select the when not connected to my PC, synchronize

with the server every check box and select a length of
time.

5. Tap [8.

Notes:

¢ To edit settings, your phone must be disconnected from your
desktop computer.

o If you create a schedule for synchronizing while connected to a
desktop computer as well as a schedule for synchronizing
remotely (wirelessly), the phone synchronizes according to both
schedules.
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%% Synchronizing Information

This section provides an overview of the types of Outlook
information you can synchronize. By default, ActiveSync
does not automatically synchronize all types of Outlook
information. Use ActiveSync options to turn
synchronization on and off for specific information types.

Synchronizing Inbox

When you select Inbox for synchronization in ActiveSync,
e-mail messages are synchronized as part of the general
synchronization process. During synchronization, the
following events occur:

e Messages are copied from the Outlook Inbox folder on
your desktop computer, or from a Microsoft Exchange
Server, to the Inbox folder on your phone.

e By default, when synchronizing Inbox information with
your desktop computer, you will receive only messages
from the last three days and the first 500 bytes of each
new message. You can also choose to download file
attachments.

e By default, when synchronizing Inbox information with a
server, you will receive only messages from the last three
days and the first 500 bytes of each new message.

e The messages on your phone and on your desktop
computer are linked. When you delete a message on your
phone, it is deleted from your desktop computer the next
time you synchronize, and vice versa.

e Messages in subfolders of other e-mail folders in Outlook
are synchronized only if the folders have been selected
for synchronization in Inbox on your phone.

Synchronizing Information

Note: SMS messages are not received in Inbox through
synchronization. Instead, they are sent to your phone by
way of your service provider.

Synchronizing Calendar

Calendar items stored on your phone can be synchronized
with calendar items stored on your desktop computer or on
a Microsoft Exchange Server. By default, calendar items
from the last two weeks will be synchronized.

Calendar items created on your phone are copied to your
desktop computer and/or server during synchronization,
and vice versa. Similarly, calendar items that are deleted
from your phone are deleted from your desktop computer
and/or server during synchronization, and vice versa. This
keeps your information up-to-date from any location.

Synchronizing Contacts

Contacts stored on your phone can be synchronized with
contacts stored on your desktop computer or on a Microsoft
Exchange Server. By default, all of your contacts will be
synchronized.

Contacts created on your Pocket PC Phone are copied to
your desktop computer and/or server during
synchronization, and vice versa. Similarly, contacts that are
deleted from your Pocket PC Phone are deleted from your
desktop computer and/or server during synchronization,
and vice versa. This keeps your information up-to-date
from any location.

o
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Synchronizing Tasks

Tasks stored on your Pocket PC Phone can be synchronized
with tasks stored on your desktop computer. Task
synchronization is automatically selected in ActiveSync. By
default, all of your incomplete tasks will be synchronized.

Tasks created on your phone are copied to your desktop
computer during synchronization, and vice versa. Similarly,
tasks that are deleted from your phone are deleted from
your desktop computer during synchronization, and vice
versa. This keeps your information up-to-date from any
location.

Note: Tasks can be synchronized only with your desktop
computer; they cannot be synchronized with a server.

#% Synchronizing Using an Infrared
Connection

You can use an infrared connection to quickly create a
direct connection between your phone and another mobile
device or desktop computer. This method is ideal for quickly
changing between multiple devices because there are no
cables or adapters to change. When creating a partnership,
you must connect using an infrared, a cable, or a cradle
connection.

For more information about synchronizing using an infrared
connection or other connection types, see ActiveSync Help
on your desktop computer.

Synchronizing Information

#% ActiveSync Errors

Whenever ActiveSync cannot successfully synchronize your
information, it displays an error on your phone.

To view more information about an ActiveSync error:

Tap when the error text is displayed. ActiveSync will
then display more information about the error that
occurred.

Note: Some types of errors can interfere with automatic
synchronization. If you suspect that a scheduled automatic
synchronization has not occurred, you should attempt to
manually synchronize your information. Successfully
completing a manual synchronization will reset automatic
synchronization. For more information, see the
“Synchronizing Information” section of ActiveSync Help on
your desktop computer.
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Navigating Through the
Applications

Navigate through your Pocket PC Phone’s applications in
three ways:

e tap
¢ tap and hold
e press application buttons

Tap the screen with the pointed tip of your stylus to open
applications and make selections. For example, tap the
Start menu to see a list of applications available.

Tap and hold an area on the screen to see a pop-up
menu.

Press an application button on the front panel to quickly
turn on the screen and open your Calendar, your
Contacts or make a recording.

Navigating Through the Applications

®% Navigating Bar and Command Bar

The navigation bar is located at the top of the screen. It
displays the active program and current time, and allows
you to switch to programs and close screens.

Y i 6:00

2003
t information

ments

Use the command bar at the bottom of the screen to
perform tasks in programs. The command bar includes
menu names, buttons, and the Input Panel button ().

To create a new item in the current program, tap New.

To see the name of a button, tap and hold the stylus on
the button. Drag the stylus off the button so that the
command is not carried out.

New button Input Panel button

|
New Edit Tools E|‘
| |

Menu names Buttons I
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Pop-up Menus

With pop-up menus, you can quickly choose an action
for an item. For example, you can use the pop-up menu
in the contact list to quickly delete a contact, make a
copy of a contact, or send an e-mail message to a
contact. The actions in the pop-up menus vary from
program to program.

To access a pop-up menu, tap and hold the stylus on the
item name that you want to perform the action on.
When the menu appears, lift the stylus, and tap the
action you want to perform. Or tap anywhere outside
the menu to close the menu without performing an
action.

Notes Y A2 347 €3
@AII Folders ~ Name
[_IMote1 9:32a 2k
[_Inote2 9:34 a 1k
[_Inotes 9:35a 826b
[_Inote4 943 a 510b
[L]quote 9:38a 12k
Create Copy Tap and hold to
Delete display the pop-up
menu.

Select All

Lift the stylus and
tap the action you

Send via E-mail...
Beam File...

want.
Rename/Move... Tap outside the
~ menutoclose it
without performing
New Tools i [ an action.
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Customizing the Application
Buttons

Your Pocket PC Phone has programmable button 1
through 5 on the front of the phone. See page xx. The
buttons are preset to Record, Calendar, Contacts,
Internet Explorer, and Inbox at the factory.

You can assign your favorite programs to the
programmable buttons; from the Start menu, tap
Settings, and then Buttons. For details, see page xx.

®% Finding Information

The Find feature on your device helps you to quickly
locate information.

1. From the Start menu, tap Find.

2. Enter the text you want to find, select a data type, and
then tap Go to start the search.

Note: To quickly find information that is taking up storage
space on your device, select Larger than 64 KB in
Type.
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3. The name of the file will appear in the box entitled

Results.

Twpe: Al data

Results

Andrea
Contack

{055) 261-5042

[mT»

E flv
Contack

987655

El hk
Contact

988

El Zima

Contact

{980) 754-3578

=] Lunch with Y5
Appointment

9/3/03 12:00PM

Buy birthday gift

Task

9/5/03

4]

[C1 Call Eana

E|A



Your Phone

As well as all the standard features of a mobile phone,
such as mailbox and call log, there are several dialing
features unique to your Pocket PC Phone. For example,
you can take notes while talking, dial directly from
Microsoft Contacts and easily transfer contacts between
your SIM card and the RAM of your device.

Additionally, like with a conventional mobile phone, you
can easily use one hand to access and navigate through
the important features of your device and make calls.

Entering Your PIN

Most SIM cards are preset with a PIN (Personal Identity
Number), provided by your mobile service provider,
which you need to enter whenever you use your device.

hone Y <0213

Enter PIN,
Only emergency calls can be made withaut &
FIM.

|| his picture will be updated In the next version.

i 2abc  Sdef Clear

ot B fmno Cancel

Foas (8tv (G
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1. Enter the preset PIN from your mobile phone service
provider (please contact your mobile service provider).

2. Tap Q on the right side of your Pocket PC Phone.

3. If your PIN is entered incorrectly three times, the SIM
card will be blocked.

If that occurs, you can unblock it with the PIN
Unblocking Key from your mobile phone service
provider.

=% Checking You Are Connected

The default settings for your Pocket PC Phone are
programmed to assume that you want to use your
phone so, providing you have inserted a SIM card, your
Pocket PC Phone will turn on your mobile phone
connection to your service provider’s network.

The icon ¥ indicates that you are connected to the
network of your mobile phone operator — A full strength
signal is indicated by ¥j| and as the strength of the
signal diminishes so will the number of vertical bars in
the icon, with no bars indicating no signal.

Note: If you have turned the phone off, removed and then
reinserted the SIM card, your Pocket PC Phone will
not automatically turn the phone on. In this event, turn
it on as described in “Turning the Phone On and Off” on
page xx.

Your Phone

%% Turning the Phone On and Off

As indicated previously your Pocket PC Phone will turn
on your phone when you insert a SIM card, however,
you can choose to turn off your phone and just use the
Pocket PC features at anytime - and then turn it back on
when you want.

Note: In many countries you are required by law to turn off
your phone when you fly. To turn off your Pocket PC
Phone doesn’t turn off your phone; you must turn off
your wireless connection to your operator’s network.

To turn the phone off:

Press and hold the D on the right side of the Pocket PC
Phone until ¥, appears in the top bar of the screen. Or,
tap Wil and then Turn phone off in the dialog box.

To turn the phone on:

Press and hold Q until ¥ appears in the top bar of the
screen. Or, tap ¥j| and then Turn phone on in the
dialog box.
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Dialer Screen

To access the Dialer Screen, tap Ja) to display the Start
menu, and select Phone. You can also press E] on the
front panel. From the Dialer screen, as well as being
able to make calls, access Call Log, Speed Dial and
Phone Setting, you can find signal status information
and important icons that tell you about your call.

This icon indicates that a call can be made and
the strength of the signal.

Last call:

Last number 4 (234) 567-89

details are Tap to

displayed
here. Gj backspace and

erase numbers.

1 2abc | 3def Call Log Tap to see all
calls received,
ghi i fmno  Speed Dial m?dedand
Keypad for missed.
inputting E 3 = Tap to see the
deae €8x list of Speed
- 0 Dial numbers.
-
Edit Tools [_] [5]
‘ I Tap to open
Click Tools — Tap to open Contacts.

Options to access  pNotes.
the phone settings.

Your Phone

The icons listed below may be seen in the top bar of the
screen:

7 In network service, tap this icon to turn off the
X | phone.

< |In network service, tap this icon to turn off the
phone.

1 | Call Missed, tap this icon to view the call(s)
W you missed.

Unread E-mail or SMS, tap the icon to view

unread SMS or E-mail.

#Il Connecting in progress, the icon will disappear
! when you are connected to your ISP.

il Shows your connection is at full strength.
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[ Making a Call Making a Call from Contacts
You can make a call from Contacts in the following way:
With your Pocket PC Phone, you can make a call from
the Dialer, Speed Dial, Call Log, and Contacts. 1. Press on the front panel. You can also tap [I=] on
the Dialer screen.

Making a Call from the Dialer 2. Find the contact and then press (=] twice. Once to

) ) send to the Dialer screen and once to call.
1. On the Dialer screen, tap the number into the keypad.
7% |Contacts Y %937 e
2. Tap Talk or press (]. e ———
. . #ab[cde] fah[ ik [Imn]apal rst Juww] sz
‘7 -C\I;:ﬁ ilhgannagllecon Tim 099876589 w
i |Phone DL D EICEEl <] when you are
Dialing. .. Carrier's Ingn making a call.
The number __ rn94) 356-349
will appear
here.
] & oo
backspace and
abc 3def Call L erase numbers
Tap the 1 2% 3 R iyidually.
number you
wish to dial Aahi EiK  Bmno  Speed Dial
' New Yiew Tools El‘
[This picture will' be Updated in the next version.
® 0+ # - (e Note: The pop-up menu and button will by default display
- Work Tel. However, you can customize so that the
Edit Tools

mobile number or e-mail is displayed instead.

3. Select a contact in the contacts list and then press left

or right on the navigation pad - the number on the
screen changes.

A A
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4. In the contacts list, tap the “w” in the right-hand column
next to the contact you want to customize. A pop-up
menu will display the phone numbers and e-mail
addresses for this contact with a dot next to the priority
number.

In the pop-up menu, select a priority. If you selected
mobile number, "m” should now be in the right-hand
column next to the contact.

lis Y wx34z €3
Wicwadse |

#ab]coe] fah | ik [ Inn]opg] rst fuva] w2

0936-875-053

* 0936-875-053 Mobhile Tel
¥| (713) 761-7195 Pager
¥| (281)817-9568 Work Fax

|| his picture will be updated In the next version.

New View Tools E|‘

Making a Call from Speed Dial

Speed dial is a list you can create of often-dialed
numbers. Information on adding a number to Speed
Dial is detailed later in this chapter.

By memorizing the position in the Speed Dial lists, you
can dial the number simply by entering that number. For
example:

Your Phone

In the picture below, “"David Boelen” is at position 4. To
dial his number, simply tap and hold 4 on the Dialer
keypad; if the number holds a position of 10 or more,
tap the first number, and then tap and hold the second
to dial.

.j_cj Phone Y 4fa951

Voice Mail

¥s

5670983245 m
Sam

(425) 876-4325 m
Boelen, David
09573436876 w
Sam

{425) B76-4325 m

New

Alternatively, if you don’t remember the position of a
number in the Speed Dial list, use the method below:

1. On the Dialer screen, press A on the navigation pad or
tap Speed Dial.

2. In the list of the Speed Dial numbers, select the number
you want to dial, and then press &]
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Making a Call from the Call Log

1. Go to Phone and press the right side of the navigation
pad or tap Call Log.

Y ¢ zz8 (D
all Calls -
¢x (092) 706-5569 2:28 p |-
(055) 665-85 2213 p
(055) 665-89 2:13p

|| his picture will be updated In the next version.

(n (055)665-85

(L (092} 706-5569 9/F/01

(092} 706-5569 9/3/01

Toals E‘*

2. Find the call details by first selecting the category it is
filed under. For example, if it is in All calls select All
Calls from the drop-down menu in the top-left corner.

3. Use the navigation pad to find the number and then

press E] or tap the icon to the left of the number you

wish to call.

Note: Icon m is for incoming calls; icon is for outgoing
calls and icon [l is for missed calls.

Your Phone

Making an International Call

1.

Tap and hold the 0 key until the + sign appears. The +
replaces the international prefix of the country from
where you are calling.

. Enter the full phone number you want to dial. It includes

the country code, the area code (without the leading
zero) and the phone number.

£ 45 01:59 €3

+1 (234) 567-89

|| his picture will be updated In the next version.

Hid Bmno  Speed Dial
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Edit Tools

. Tap Talk or press (&~].
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Making an Emergency Call

Enter the international emergency number 112 then tap
Talk or press (&].

Notes:

e Your Pocket PC Phone provides the international emergency
number 112. This number can normally be used to make an
emergency call in any country, with or without a SIM card
inserted, if a mobile phone service networks within.

¢ Some mobile phone service providers may require that a SIM
card is inserted, and in some cases that the PIN has been
entered as well.

¢ In some cases, other emergency numbers may also be
accessed. Your mobile phone service provider may save
additional local emergency numbers in the SIM card.

Your Phone

Answering or Rejecting a Call

To answer or reject a received call:
e Tap Answer, or press (=] on your Pocket PC Phone.
« Tap Ignore, or press ) to reject the call.

£ 4<358 O

Phone - Incoming...

[425) 1234565759

|| his picture will be updated In the next version.

Edit Tools [_]

Note: If you reject a call, the busy tone is sent out.
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Ending a Call

Once an incoming or outgoing call is proceeding, you
can press [a or tap End to end the call.

Options During a Call

Your phone provides a number of control functions that
you can use while a call is in progress.
Enabling the Speakerphone Mode

Your Pocket PC Phone has a speakerphone allowing you
to talk hands-free and/or let other people to listen to
the caller.

1. Wait until the phone is ringing.

2. Hold down S] until the speakerphone comes on and
4.~ appears in the top toolbar.

e 6 4814

Speakerphone is an.

|| his picture will be updated In the next version.

ki Sk Bmno  Speed Dial

Feas B O Hold

* 0+ H t, End

Edit Tools
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3. To turn off the speakerphone, hold down S] again.

Note: Do not leave the phone in the Speakerphone mode and
hold it on your ear; the sound may damage your ear.

Putting a Call on Hold

1. If another person is trying to call you when you are
talking on the phone, the screen below will pop out.

2. Tap Answer to take the second call and put the first on
hold.

£l 4% 1:36 €

Phone - Incoming...

(425) 1234567

|| his picture will be updated In the next version.
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Edit Tools

3. To swap back and forth between 2 callers, tap Swap.

4. To end the second call and go back to the first, tap End

or press [ #).
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Setting Up Conference Calling

1. Either put a call on hold, dial a second number and wait
for it to be picked up. Or, accept a second incoming call
when you already have one in progress.

2. In the screen that appears, tap Conference.

Duration: 0046
[0913) 634-22 (Cn Hold )

{092) 195-15

|| his picture will be updated In the next version.

i 5K Bmne  Conference

7|:n:|r-_: stu*.-' Y Swap

* # % End
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3. If the conference connection is successful, the word
“Conference” will appear at the top of the Dialer screen.

1 [Phone £ 15 1244 €3

Duration: 01:05

Conference

|| his picture will be updated In the next version.
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Edit Tools [|_|

4. To add additional people to your conference call, tap
Hold, key in the number, and then Resume to return
and continue.
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Making a Note

Regardless of whether you call from the Dialer,
Contacts, Call Log, Speed Dial or SIM Contacts, you
can take a note during a call. After you have finished the
note, it will be saved as an attachment to your call in
one of the Call Log folders.

To make a note:

1. After you have entered a number and pressed E] or
tapped Talk, tap at the bottom of the screen.

2. Use any of the input methods to record your note and
then tap . You can finish your note during or after the
call.

fINotes &) Vil 45 551 (O

Caller: -
Company: I
Phone: (096) 356-349

Date & Time: 9/5/01, 5:51 a

Notes:

|| his picture will be updated In the next version.
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Viewing a Note

To view a note:

e Press the right side of the navigation pad or tap Call Log
on the Dialer screen, tap and hold the call, and then from
the pop-up menu, tap view note. (@' indicates a note).

¢ Or, go to Notes, and then tap the name of the file from
the list. (For more information, see page xx.)

# |Phone Yil A€ 218 @
all Calls -
1(234) 567-89 217 p|~ A note is
E attached.

Voice Mail 122 pl=
222
1(234) 567-89 1:02 p[—

|| his picture will be updated In the next version. |

1(234) 567-89 11:26 a

1 (234) 567-89 11:23 a

Vaoice Mail 11:22 a
222

Tools E|A

]

Note: When you want to create a contact for this caller, see
“Adding and Transferring Contacts Information” on
page xx. The call and file names will be amended to the
name of the new contact; the file will be unaffected.
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Call Related Features

Checking Your Voice Mail

The first speed dial location defaults as your voice
mailbox. When you insert your SIM card into your
Pocket PC Phone, it will automatically detect and set as
default the voice mailbox number of your mobile service
provider.

il 42 442 D

Voice Mail
222

|| his picture will be updated In the next version.

To retrieve your voice mail, press E], the left side of
the navigation pad, select Voice Mail and then

press (&].

Your Phone

Adding and Transferring Contact
Information

There are a number of ways in which telephone
numbers and contacts can be entered and stored, and
there are also a number of ways to make a phone call. It
is therefore important to be able to transfer those
contacts between the programs used to make a call.

Places where contacts can be entered your device
and be stored

e Your SIM card: You can interchange your SIM card
between your Pocket PC Phone and other devices; while
using other devices you can create one or more new
contacts on the SIM card.

¢ Microsoft Contacts.

e Call Log: New contact numbers can be found in incoming
calls or missed calls.

Why transfer numbers?

¢ In the event you lose your SIM card while using it with
another device, your SIM numbers will be backed upon to
your device.

¢ If you want to transfer a number to Speed Dial, it must
be in Contacts, not on the SIM card.

e If you are using your SIM with another device, you may
need the numbers stored in Microsoft Contacts.

¢ Transferring numbers to Microsoft Contacts allows you
to create a more detailed record.

&



Your Phone

Microsoft Contacts: Adding and
Transferring Contacts

1. To create a contact, see “Creating a Contact” on page
XX.

2. To transfer a contact to SIM, press and hold the center
of the navigation pad, or tap and hold the contact, and
then select Save To SIM from the pop-up menu.

Contacts

fi Y D606 &3
Meontacts» [ ]

#ab[cde| foh [ ik [Imn]opg] rst Juew] xve

Andrea 9870543678 w
Eun {345) 789-6543 m
John (0B7) 653-2566 w
Young {425) 345-5677 w

Save To 5IM i

Phonebook

Send SMS

Create Copy

Delete Contack

Send E-mail to Contact...

Beam Contact...

Call Mobile Tel

Add speed Dial Mobile Tel El‘

3. To transfer a contact to Speed Dial, press and hold the
center of the navigation pad, or tap and hold the
contact, and then select Add Speed Dial Work Tel
from the pop-up menu.

4. Add the contact details in the next screen, select a
location and tap [o§.

Your Phone

Note: By default the Location function will assign you the
next available position in the Speed Dial list. If you
want to put a number in a position that is already
occupied, the new number will replace the previous

number.

Managing Your Call Log

The Call Log details all incoming, outgoing, and missed
calls and also provides a summary of total calls. The
Call Log can also tell you when a call was initiated, how
long it lasted, and provides easy access to any notes

taken during the call.

Tap here to

Time of
call

21133

select All al Ea“EP; E———
: ortison, Peter
Ca";’ Dtlllss_ed, +44 2222 22222 W
u g_omg, Cavey, Chris
Incoming or +44 2222 22225 W
By Caller. Chau, Jim

2:08 &2

|| nis picture will be updated In the next version.
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Viewing Details of Calls

Tap in the top left corner of the screen and then select a
category from the drop-down menu.

Calls are categorized as below:

¢ All Calls: shows all calls made to and from the phone in
chronological order.

o m Missed: only shows calls that were not answered.
o Outgoing: only shows calls made from the phone.
. m Incoming: only shows calls made to the phone.

¢ By Caller: categorizes calls alphabetically according to
caller.

To view duration of call, go to Call Log, find the call you
are interested in, and then tap it once to highlight it.

() {091) 672-9375 9/4/01

Lo {091) 672-9375 9/4/01

T R

|| his picture will be updated In the next version.

1 LyLIury EJETN
(777) 787-688 w
Ttyuuhg 9/4/01|
(777) 787-688 w -
Tools E|“

To delete individual calls from Call Log, press and hold
the center of the navigation pad, and then select delete
from the pop-up menu.

To delete all calls from Call Log, tap Tools — Delete all
calls.

Your Phone

To set limits on the size of your Call Log:

1. Tap Call Log — Tools — Options, and then the box
under Delete call log items older than.

2. In the drop-down menu choose a period of time and
then tap [6.

Y 42459

Opticins

Al Calls:
25 min, 38 sec
19 cals

Recent Calls:

AE i OO e

|| his picture will be updated In the next version.

Delete call log iters older than:

Viewing Call Cost

This network feature lets you view the cost of calls. You
can set the max cost to limit the cost of your calls to a
certain amount of charging units or units of currency.
When the max cost is active, calls can be made only as
long as the preset max cost is not exceeded.

&
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To view the cost of calls:

1. From the Start menu, select Settings.

2. Tap the System tab and then select Call Cost.

In the Call Cost window, you see the last call time, total
cost of all calls made since the cost counter was last
reset, the maximum cost set in the Set Max Cost
option, and the price per unit.

You can also set the following options. You must enter
your PIN1.

Reset Counters: allow you to reset the cost counter.

Set Max Cost: allows you to enter the maximum cost
that you authorize for your calls.

When the max cost you have set is reached, the counter
stops at its maximum value and you can no longer make
any calls until you reset the counter.

Price/Unit Set: allows you to set the cost of one unit.
This price per unit is applied when calculating the cost of
your calls.

Your Phone

Customizing Your Phone

You can personalize the setting of your phone, the
services you have and the network you are connected
to.

Phone Settings

You can select ring type, ring tone, and keypad to your
liking. Downloading ring tones is also available.

Selecting Ring Type and Tone, and Keypad Sounds

1. Go to Phone, tap Tools —» Options.

¥ settings il 45 512
Phone
Phone Mumber: Mot awalable fram SIM

Sounds:

Rirg e [T | ©2YS the

Ring tore: [Rapidbean 0= selected ring.
Keypad:  [Tones Wl

Chmmm e n el

|| his picture will be updated In the next version. |

Decuiwy:

Require PIN when phone is used

Change PIN

Phﬂn’el Serviges | Metwork | Mnre‘

Ela.

2. In the Phone tab, tap the down arrow in each field to
see the drop-down menu choices.
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Downloading Ring Tones

You can connect to the Internet and then download ring
tones that are compatible with the.WAV format.

Security Settings

Enabling the PIN

1. Go to Phone, tap Tools —~ Options.

2. In the Phone tab, tap the option Require PIN when
phone is used under Security.

Changing the PIN

1. Under Security, tap Change PIN.

i Gz (D
Sounds:
Ring type: |Rihg '|
Ring tone: [BeliDitty M0
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2. Follow the instructions on the screen.
Enter the old PIN, then a new one, and re-enter for
confirmation.

Enabling Caller ID

When you place a call, your phone number will be
displayed to the person that you are calling. To enable
or disable this function:

1. Go to Phone, tap Tools —~ Options.

2. In the Services tab, tap Caller ID — Get Settings
(retrieving settings may take a few minutes).

Y 4600 Ty

To access settings for a service, sslect it
fromn the following list and tap ‘Get
Settings'.

[This picture will be updated in the next version.
I |

Get Settings...

Phene | Sewiues| Netw\:lrk‘
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3. In the next screen, select either Everyone I call
(Enable) or Never provide caller ID (Disable) and
then [o8.

Y\
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Network Settings

Finding a Network

1. Go to Phone, tap Tools > Options.

2. In the Network tab, tap Find Network (retrieving
settings may take a few minutes).

Settings Vil ¢ 10:16 (D

Phone

Current network,  Carrier's logo

Find Network

Network selection:
i@ Automatic
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Note: You can enable this function when the network status is
currently out of network service and you want to
conduct a search.

Your Phone

£1|settings il 4¢ 10:26 (%
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Selecting a Network

1. Go to Phone, tap Tools > Options.

2. Tap the Network tab, and then select either Automatic
or Manual in Network selection (retrieving settings
may take a few minutes when you select Manual).

Setting Preferred Networks

1. Go to Phone, tap Tools and then Options.

2. In the Network tab, select Set Preferred Networks
(retrieving settings may take a few minutes).

Y\
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[ |settings Vi 4< 1051 (Qh

Phone: Preferred networks

Select your preferred netwerks and onder
them to your preference.

[_]Tone Telecoms 1800
[ ]KM Telecom
[ ]Chwahung GSM 1800
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3. Select either networks and re-prioritize the order for
network usage.

Note: If there are many mobile phone service providers
available to you, enable this function to select a lower
fee network.

Call Forwarding

This service allows you to forward your incoming calls to

another phone number. You can choose to forward all

calls to the same number or specify a number based on

the following conditions:

Unavailable: If your phone is turned off or your phone

is out of the network service.
Busy: When you are on the phone.

No answer: If you do not answer your phone.

Your Phone

To activate or deactivate call forwarding:

1.

2.

Go to Phone, and tap Tools —» Options — Services.

In the Services tab, tap Call forwarding > Get
Settings (retrieving settings may take a few minutes).

. In Call forwarding, either check the Forward all

incoming phone calls box and then enter a number in
the box below or, according to circumstance, select one
or all of the other categories and enter numbers.

7 |settings Vil 4¢ 12223 (G

Phone: Call forwarding

[ Farward &l incoming phane cals
TD:| ‘

Forward phane cals only if:
Unavailable;
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Call Waiting

This service allows you to receive another call during an
active call. You can also turn this option off by selecting
Do not notify me.

To activate or deactivate call waiting:

1.

2,

Go to Phone, and tap Tools —~ Options —~ Services.

In the Services tab, tap Call waiting ~ Get Settings
(retrieving settings may take a few minutes).

Then in Call waiting, select Notify me or Do not
notify me and tap [og.

i |Settings il 4% 6:04 (D

Phone: Call waiting

whien calls are weaiting:
() Motify e
() Do not notify me
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Voice Mail and SMS

By default your device will automatically detect and set
your voice mail and SMS access numbers. However, you
can view the settings if you want.

Viewing Your Voice and SMS Access Numbers

1. Go to Phone, and tap Tools > Options > Services.

2. In the Services tab, tap Voice mail and SMS - Get
Settings (retrieving settings may take a few minutes).

3. Then in Voice mail and SMS, type in the access
numbers and tap [of.

HlFlcattings Yil 4632 (D
Phone: woice mal and SMS

T
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Sending a Message in Phone Dialer

1. On the Dialer screen, tap Tools > Send SMS.

il 42 500 €3

Last call:

(092) 605-3697
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New Edit My Text [7=] E|A
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messages. recording toolbar.

Tap to display Address

A Book.

. Tap to show or
= hide the

Your Phone

. Tap New.

. In the To field, enter either e-mail address or SMS

number of one or more recipients, separating them
with a semicolon, or select a name from the contact list
by tapping the Address Book button. All e-mail
addresses entered in the e-mail fields in Contacts
appear in Address Book.

. Compose your message. To enter preset or frequently

used messages, tap My Text and select a message.

. Tap Send when you've finished the message. If you are

working offline, the message is moved to the Outbox
folder and will be sent the next time you connect.
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Checking Your Voicemail

The first speed dial location defaults as your voice
mailbox. When you insert your SIM card into your
Pocket PC Phone, it will automatically detect and set as
default the voice mailbox number of your mobile service
provider.

To retrieve your voice mail:

On the Dialer screen, press the left side of the
navigation pad, select Voice Mail and then press E]

il 4% 4:42 (D

Yoice Mail
222
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Message, Internet and
Messanger

== Inbox: Sending and Receiving E-

mail or SMS

Use Inbox to send and receive e-mail messages in
either of these ways:

e Synchronize e-mail messages with Microsoft Exchange or
Microsoft Outlook on your PC.

¢ Send and receive e-mail messages by connecting directly
to an e-mail server through an Internet service provider
(ISP) or a network.

You can also use Inbox to send and receive SMS; it
supports 8 bits data with class 0, 1, 2, 3, and
Unstructured Supplementary Service Data (USSD).

Synchronizing E-mail Messages

E-mail messages can be synchronized as part of the
general synchronization process. You will need to enable
Inbox synchronization in ActiveSync. For information on
enabling Inbox synchronization, see “ActiveSync Help”
on the PC.

During Synchronization

e Messages are copied from the mail folders of Exchange or
Outlook on your PC to the ActiveSync folder in Inbox on
your device. By default, you will receive messages from
only the past five days, and only the first 100 lines of
each message.
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e E-mail messages in the Outbox folder on your device are
transferred to Exchange or Outlook, and then sent from
those programs.

e E-mail messages in folders must be selected in
ActiveSync on your PC in order to be transferred.

Connecting Directly to an E-mail Server

In addition to synchronizing e-mail messages with your
PC, you can send and receive e-mail messages by
connecting to an e-mail server using a modem or
network card connected to your device. You'll need to
set up a remote connection to a network or an ISP, and
a connection to your e-mail server.

When you connect to the e-mail server, new messages
are downloaded to the device’s Inbox folder. Also
messages in the device’s Outbox folder are sent, and
messages that have been deleted on the e-mail server
are removed from the device’s Inbox folder. Messages
that you receive directly from an e-mail server are
linked to your e-mail server rather than your PC. When
you delete a message on your device, it is also deleted
from the e-mail server the next time you connect based
on the settings you selected in ActiveSync.

You can work online or offline. When working online,
you read and respond to messages while connected to
the e-mail server. Messages are sent as soon as you tap
Send, which also saves space on your device. When
working offline, once you’ve downloaded new message
headers or partial messages, you can disconnect from
the e-mail server and then decide which messages to
download completely. The next time you connect, Inbox
downloads the complete messages you've marked for
retrieval and sends the messages you've composed.

Message, Internet and Messanger

Using the Message List

Messages you receive are displayed in the message list.
By default, the most recently received messages are
displayed first in the list.

Select the service and folder you
want to display.

Select the sort for

message.
e o
Inbox - Received Date

& Robert Brown

Mectine Tap to open a

RE: Today"
&y Jay Adams Mark as Unread message.

RE: Psse 1y Mgve To. i Tap and hold to
& gpatiwpg:;? Mark for Download display a pop-up of
& tradey et =  actions.

RE! Lunch Reply
|| his picture will be updated In the next version.
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4

Inbox: AckiveSyne 11 Items.

New Tools Services [ E|l

‘ \;Tap to connect to send

Tap to connect to  and receive e-mail.
the selected
service.
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When you receive a message, tap it to open it. Unread
messages are displayed in bold.

Tap to return to
From: Robert Brown the message list.
Subjeck: RE: Today's Mesting
Senk: 423001 8145047 oM

Just 3 reminder to bring wour individual
schiedules for the next 2 guarters with
vou, e will be discussing projects and
timelines.

Tharks,
Roh
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Tap to delete
[ this message.

New Edit Ija Et & ¥ E|‘“

LTap to view the previous or
Tap to reply to next message.
or forward this
message.

When you connect to your e-mail server or synchronize
with your PC, by default, you'll receive messages from
only the last five days, and only the first 100 lines of
each new message. The original messages remain on
the e-mail server or your PC.

You can mark the messages that you want to retrieve in
full during your next synchronization or e-mail server
connection. In the message list, tap and hold the
message you want to retrieve. On the pop-up menu, tap
Mark for Download. The icons in the Inbox message list
give you visual indication [i? of message status.
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You specify your downloading preferences when you set
up the service or select your synchronization options.
You can change them at any time:

¢ Change options for Inbox synchronization using
ActiveSync options. For more information, see
“ActiveSync Help.”

¢ Change options for direct e-mail server connections in
Inbox on your device. Tap Tools and then tap Options.
In the Service tab, tap the service you want to change.

Tap and hold the service and select Delete to remove a
service.
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Creating an SMS or E-mail

1. Tap New.

Tap to send the message.

Send[subi €. = ¥ Tap to show or
| hide the
complete header.

New Edit My Text [=5] E|A

L Tap to show/hide the

Tap to insert recording toolbar.
common Tap to display
MESSages. e Address
Book.

2. In the To field, enter either e-mail address or an SMS
number of one or more recipients, separating them with
a semicolon, or select a name from the contact list by
tapping the Address Book button. All e-mail addresses
entered in the e-mail fields in Contacts appear in
Address Book.
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3. Compose your message. To enter preset or frequently
used messages, tap My Text and select a message.

4. Tap Send when you've finished the message. If you are
working offline, the message is moved to the Outbox
folder and will be sent the next time you connect.

Note:

o Whether you want to send or read an e-mail or an SMS, you
can swap it by tapping Services then choose what service
you want.

o If you are sending an SMS message and want to know if it
was received, tap Edit, Options, and select Request SMS
text message delivery notification before sending the
message.

Managing Messages and Folders

By default, messages are displayed in one of five folders
for each service you have created: Deleted Items,
Drafts, Inbox, Outbox, and Sent Items. The
Deleted Items folder contains messages that have
been deleted on the device. The behavior of the
Deleted and Sent Items folders depends on the
options you have chosen. In the message list, tap Tools
and then Options. In the Message tab, select your
options.

If you want to organize messages into additional
folders, tap Tools, and then Manage Folders to create
new folders. To move a message to another folder, in
the message list, tap and hold the message and then
tap Move to on the pop-up menu.

&



Message, Internet and Messanger

Folder Behavior with a Direct Connection to
an E-mail Server

The behavior of the folders you create depends on
whether you are using ActiveSync, SMS, POP3, or
IMAP4,

1. If you use ActiveSync, e-mail messages in the Inbox
folder in Outlook will automatically be synchronized
with your device. You can select to synchronize
additional folders by designating them for ActiveSync.
The folders you created and the messages you moved
will then be mirrored on the server. For example, if you
move two messages from the Inbox folder to a folder
named “Family”, and you have designated “Family” for
synchronization, the server creates a copy of the
‘Family’ folder and copies the messages into that folder.
You can then read the messages while away from your
PC.

2. If you use SMS, messages are stored in the Inbox
folder of SMS category.

3. If you use POP3 and you move e-mail messages to a
folder you created, the link is broken between the
messages on the device and their copies on the mail
server. The next time you connect, the mail server will
see that the messages are missing from the device
Inbox and delete them from the server. This prevents
you from having duplicate copies of a message, but it
also means that you will no longer have access to
messages that you move to folders created from
anywhere except the device.
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4. If you use IMAP4, the folders you created and the e-mail
messages you moved are mirrored on the server.
Therefore, messages are available to you anytime you
connect to your mail server, whether it is from your
device or PC. This synchronization of folders occurs
whenever you connect to your mail server; create new
folders, or rename/delete folders when connected.

Transferring Items Using Infrared

Using infrared (IR), you can send and receive
information, such as contacts and appointments,
between two devices.

Sending Information

1. Switch to the program where you created the item you
want to send and locate the item in the list.

2. Align the IR ports so that they are unobstructed and
within a close range.

3. Tap and hold the item, and tap Beam Item on the pop-
up menu.

Note: You can also send items, but not folders, from File
Explorer. Tap and hold the item you want to send, and
then tap Beam File on the pop-up menu.
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Receiving Information

1. Align the IR ports so that they are unobstructed and
within close range.

2. Have the owner of the other device send the information
to you. Your device will automatically receive it.

== Internet Explorer

Use Microsoft® Pocket Internet Explorer to view Web
HTML, cHTML and WAP pages. You can browse in either
of these ways:

e During synchronization with your PC, download your
favorite links and mobile favorites that are stored in the
Mobile Favorites folder in Internet Explorer on the
PC.

e Connect to an Internet service provider (ISP) or network
and browse the Web. To do this, you'll need to create the
connection first as described on page XX.

When connected to an ISP or network, you can also
download files and programs from the Internet or
intranet.
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Using Internet Explorer

Switching to Internet Explorer

From the Start menu, tap Internet Explorer.

Internet Explorer Y £ 9:49 °

Tap below for useful sites and services!

% PocketPC.com
OEM
msn* Mobile

@A Avant Go-

view Tools & £ &% C0 &) E|A

Favorites button

You can use Internet Explorer to browse mobile
favorites and channels that have been downloaded to
your device without connecting to the Internet. You can
also connect to the Internet through an ISP or a
network connection and browse the Web/ WAP page(s).

Note: The web page of your operator should appear in the
blank space in the picture to the left.

A
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Viewing Mobile Favorites and Channels

1. Tap the Favorites button to display your list of

favorites.

:5,_ Internet Explorer Y % 9:49 @

Favorites

Aant nnels .
~* MSH Mabile Tap the favorite

[ Pocket PC Web Guide you want to view.
Pocket PC.com

----- &) windowsMedia.com

Open | Add { Delete I Tap to add or delgte
E|‘ a folder or favorite
link.

2. Tap the page you want to view.

3. You'll see the page that was downloaded the last time

you synchronized with your PC. If the page is not on
your device, the favorite will be dimmed.

You will need to synchronize with your PC again to
download the page to your device, or connect to the
Internet to view the page.
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Browsing the Internet

1. Set up a connection to your ISP or corporate network
using Connections, as described on page XX.

2. To connect and start browsing, do one of the following:

e Tap the Favorites button, and then tap on what you
want to view.

e Tap View and then Address Bar. In the address bar
that appears at the top of the screen, enter the Web
address you want to visit and then tap Go. Tap the
arrow to choose from previously entered addresses.

Note: To add a favorite link while using the device, go to the
page you want to add, tap and hold on the page, and
tap Add to Favorites.

The Mobile Favorites Folder

Only items stored in the Mobile Favorites folder in
Internet Explorer on your PC will be synchronized with
your device. This folder was created automatically when
you installed ActiveSync.



Message, Internet and Messanger

Favorite Links

During synchronization, the list of favorite links in the
Mobile Favorites folder on your PC is synchronized
with Pocket Internet Explorer on your device. Both PC
and your device are updated with changes made to
either list each time you synchronize. Unless you mark
the favorite link as a mobile favorite, only the link will be
downloaded to your device, and you will need to connect
to your ISP or network to view the content. For more
information on synchronization, see “ActiveSync Help”
on the PC.

Mobile Favorites

If you are using Microsoft Internet Explorer 5.0 or later
on your PC, you can download mobile favorites to your
device.

To synchronize mobile favorites, download Web contents
to your device so that you can view pages while you are
disconnected from your ISP and PC.

Use the Internet Explorer plug in installed with
ActiveSync to create mobile favorites quickly.

Creating a Mobile Favorite

1. In Internet Explorer on your desktop computer, click
Tools > Create Mobile Favorite.

2. To change the link name, enter a new name in the
Name box.

3. In Update, select a desired update schedule.
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4. Click [6]. Internet Explorer downloads the latest version
of the page to your desktop computer.

5. Limit the number of downloaded linked pages. In
Internet Explorer on the desktop computer, click
Favorites; then move your mouse through Mobile
Favorites to the mobile favorite you want to change.
Finally, right-click the mobile favorite and then
Properties; in the Download tab, specify 0 or 1 for
the number of linked pages you want to download.

6. Synchronize your device and desktop computer. Mobile
favorites that are stored in the Mobile Favorites folder
in Internet Explorer are downloaded to your device.

Note:

o If you did not specify an update schedule in step 3, you will
need to manually download content to keep the information
updated on your desktop computer and device. Before
synchronizing your device, in Internet Explorer on your
desktop computer, click Tools ~ Synchronize. You will see
the last time the contents were downloaded to the desktop
computer, and you can manually download other contents if
needed.

e You can add a button to the Internet Explorer toolbar for
creating mobile favorites. In Internet Explorer on your
desktop computer, click View —~ Toolbars ~ Customize.
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Saving Device Memory

Mobile favorites take up storage memory on your
device. To minimize the amount of memory used:

o In ActiveSync on your desktop, click Options —~
Favorites/Internet Explorer ~ Settings
Customize. You can then deselect Synchronize
Images ~ Synchronize Sound and/or Synchronize
offline content pages, to stop pictures and sounds, or
some mobile favorites from being downloaded to the
device. For more information, see “ActiveSync Help.”

e Limit the number of downloaded linked pages. In
Internet Explorer on the desktop computer, click
Favorites; then move your mouse through Mobile
Favorites to the mobile favorite you want to change.
Finally, right-click the mobile favorite and then
Properties. In the Download tab, specify 0 or 1 for the
number of linked pages you want downloaded.

Browsing the Internet

1. Set up a connection to your ISP or corporate network
using Connections, as described on page XX.

2. To connect and start browsing, do one of the following:

e Tap the Favorites button, and then tap on what you
want to view.

e Tap View ~ Address Bar. In the address bar that
appears at the top of the screen, enter the Web
address you want to visit and then tap Go. Tap the
arrow to choose from previously entered addresses.
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Note: To add a favorite link while using the device, go to the
page you want to add, tap and hold on the page, and
tap Add to Favorites.

Using AvantGo Channels

AvantGo is a free interactive service that gives you
access to personalized content and thousands of popular
Web sites. You subscribe to AvantGo channels directly
from your device. Then, synchronize your device and
PC, or connect to the Internet to download the contents.
For more information, visit the AvantGo Web site.

Signing up for AvantGo

1. In ActiveSync options on the desktop computer, turn
on synchronization for the AvantGo information type.

2. In Internet Explorer on your device, tap the
Favorites button to display your list of favorites.

3. Tap the AvantGo Channels link.

4. Follow the directions on the screen. You will need to
synchronize your device with your desktop computer
and then tap the My Channels button to complete the
AvantGo setup.

When synchronization is complete, tap the AvantGo
Channels link in your list of favorites to see a few of the
most popular channels. To add or remove channels, tap
the Add or Remove link.

A
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jBrowser 3.0

Using jBrowser, you can browse the WAP (Wireless
Application Protocol) sites on your Pocket PC Phone.

Connecting to a Web Site

1.

From the Start menu, tap Programs — jBrowser 3.0.
You are now connected to the homepage of the Wireless
Web service provider.

The content of the jBrowser startup homepage depends
on the service provider.

Address bar
a{ s O

Tap to display all fttpy/[defnde.wap. | ~|Go | Tap to enter the

the recently web site.

visited web sites.

Eaf RS S s RN

Go ¥Yiew Tools Help E|‘

Tools used for
navigating WAP
pages.
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2. To open a web site, enter the address of the web site in

the Address bar.

You can also use the URL Wizard to enter the URL.
Tap Go and then select Open URL. Words used often
in the URL are specified in the list box in the URL
Wizard.

FF|URL wizard Y <844

wrL |

file:ff rniohile, .Cam
httpef¥ wap, .in
https:ff W, .arg

[defauitasp |& | 7 | _ |# |@ |

| Undo | |I3Iear AII| | Go |

Go ¥iew Tools Help E|‘

. Tap Go to fetch the page from the web site.

. While you are navigating through the WAP pages, you
can use the following options by tapping icons on the
toolbar:

To tap

go to the previously visited site

go to the homepage

& B2 | [

stop loading the current page
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— tap Using Favorites
display the list of links in the current page which = You can store your favorite web sites and then access
allows you to go to the other links present on the them eaglly. Categorizing them enables you to find them
current page more quickly.
refresh the current page i To add an URL as a favorite:
display the list of favorites . .
1. In jBrowser, tap Go —~> Add to Favorites. The Add New
enlarge the page view @& dialog box displays.
search data containing a word you enter 2]
allow you to navigate from several open IH Mame | |
windows |http:{‘,-r | |http:,f,,f\n\u'ap.yahoo.corn,f |
protect your data against unauthorized g Categary | -]
access
Opening Multiple Window Category

You can open multiple URLs at the same time in

different windows. jBrowser provides options to clone a
page, open a new window and to close a window.

To open a new window, tap Go > New Window. (£ U s (] =)

To open a new window with the same contents as the You can also access this feature by tapping on the
current window, tap Go — Clone Page. toolbar and then Add New.

To navigate between the windows, tap [ on the 2. Enter a name for the favorite site, the URL of the site,

toolbar. and select a category from the list under which you

To close the current window, tap Go — Close Window. want to save the favorite. You can also create a new or
delete a category on this screen.

3. Tap Add.

A A
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To open a page through favorites:

1. Tap on the toolbar or tap Go — Favorite. The
favorites under the selected category are displayed in
the window.

2. Select a category, if necessary, and select the site you
want, and then tap Go.

To delete a favorite under a particular category:

In the Favorite window, select the site you want to
delete, and then tap Delete.

Message, Internet and Messanger

Using the History

The History list keeps track of all of the web sites you
visited.

To view the history:

1. In jBrowser, tap Go — History. The History dialog box
displays all of the recently visited URL's. The history
entries are displayed by page title or page URL
according to your choice.

E%] ibrowser

Gif Inage Wiewer
g
VAP 15tasm
W APE 1stasyu

bitpe/ 102, 10032 wimilfwapomai
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[Clear History | | Go |

Go Edit ¥iew Tooks Help E|‘
2. To open a page in the history, select the URL and tap
Go.

3. To clear the history, tap Clear History. The Clear
History option clears all entries in the history list.
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Viewing Push Messages

GENERAL, SIMPLE, EASY TO UNDERSTAND BRIEF
INTRODUCTION ABOUT PUSH MESSAGE IS REQUIRED.
BRIEF INTRODUCTION ABOUT PUSH MESSAGE IS

To configure the push settings:

1. In jBrowser, tap Tools > Options > Push.

2. Enable the settings required and tap .

To view the messages that are pushed:

1. In jBrowser, tap View — Push Inbox.

3 Push Message Y o 11:17 @

Select Inbox or — [T v [Detaled — +
Archive. 0 Messages 0 MNew
S| ! | From | Message | Time

<] 1] [ D

4] D

|Archive | | Delete | |Pr|:||:ess |

Go Yiew Tools Help El‘

2. You can select Detailed or Simple from the box at the
top right. The Detailed option allows you to see the
messages with all the details of status, priority, address,
and time of receiving.
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3. To archive a message present in the Inbox, select the
message and tap Archive.

To go to the URL specified in the message, tap Process.

To delete a message, select the message and tap
Delete.

Setting the jBrowser Options

Display Options
You can select the following display options:

e Graphics can be hidden or displayed when you read a
WAP page.
e The contents of the web page can be fit to screen.

To enable graphics contents in your browser skin, tap
View — Display, and check Graphic.

To wrap the contents within the width of the screen, tap
View — Display, and check Fit to Screen. You have to
refresh the screen after selecting this option.

Statistics

jBrowser provides statistical information about the data
transfer over the web server. To view the statistical
information, tap View — Statistics.

The information about the pages viewed, objects
fetched, the number of bytes sent and received, and the
average page size are displayed.

A
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Connection

You can choose the connection type. Tap Tools —
Connections. You can also disconnect the existing
connection on this screen.

Settings

You can view the current settings of jBrowser. You can
change an active profile or edit a selected profile.

To access this feature, tap Tools —~ Options — Settings.

Style

You can customize the appearance of the text in
jBrowser. You can change the font face, size, color and
style. A preview with sample text is displayed.

To access this feature, tap Tools —~ Options — Style.

Cache/Cookie

Viewed pages can be cached for faster downloads,
Cookies store information related to a session. You can
select to enable or disable cache or cookie.

To access this feature, tap Tools ~ Options —~ Cache/
Cookie. You can also clear cache or cookie on this
screen.
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Using jBrowser Help

In jBrowser, tap Help at the bottom of the screen. You
can access online help for the jBrowser features.

MSN Messenger

MSN® Messenger on your mobile device is an instant
messaging program that lets you:

e see who is online.
e send and receive instant messages.

¢ have instant message conversations with groups of
contacts.

To use MSN Messenger, you must have a Microsoft
Passport™ account or a Microsoft Exchange e-mail
account. If you have a Hotmail® or MSN account, you
already have a Passport. Once you have obtained either
a Microsoft Passport or a Microsoft Exchange account,
you are ready to set up your account.

Note: Sign up for a Microsoft Passport account at http://
www.passport.com. Get a free Microsoft Hotmail e-mail
address at http://www.hotmail.com.

Switching to MSN Messenger

From the Start menu, tap Programs ~ MSN
Messenger.
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Setting Up

Before you can connect, you must enter Passport or
Exchange account information.

Setting up an Account and Sign in

1. In the Tools menu, tap Options.

2. In the Accounts tab, enter your Passport or Exchange
account information.

3. To sign in, tap the sign in screen and enter your e-mail
address and password.

To Change from Your Exchange Account to Your
Passport Account, and Sign in

1. In the Tools menu, tap Options.

2. In the Accounts tab, tick Enable Passport account,
enter your Passport account information; under Sign in
using this account first tick Passport account, and

then tap [6.
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MSN Messenger Q.I '?||I < 215 @

Accounts

Enable Passport account
Sign in name:

Password:

D Enable Exchange account

|| his picture will be updated In the next version.

Sign in using this account first
@ Passport account
@ Exchange account

General | Privawlmmun‘tsl

ElA

3. To sign in, tap the sign-in screen and enter your e-mail
address and password.

Note: If you already use MSN Messenger on your PC, your
contacts will show up on your device without being
added again.
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Working with Contacts

The MSN Messenger window shows all of your
messenger contacts at a glance, divided into Online and
Not Online categories. From this view, while connected,
you can chat, send e-mail, block the contact from
chatting with you, or delete contacts from your list using
the pop-up menu.

f|r5M Messenger s 509 €3

i Kim Akers {Online)

A online

_.1 Adarn Barr
4 Tap a contact to

Ei Fandall {fuaray)
‘1 Mot Online

|| his picture will be updated In the next version. |

start a chat.

Send an Instant Message
Send Mail {Tim@woodgrovebank.c...

Block Tap and hold to
Delete Contact disp|ay a pop-up
Properties menu of actions.

Tools Chats El-ﬂ

Note: To see others online without being seen, in the Tools
menu, tap My Status -~ Appear Offline. If you block
a contact, you will appear offline but will remain on the
blocked contact’s list. To unblock a contact, tap and
hold the contact, then tap Unblock on the pop-up
menu.
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Chatting with Contacts

Tap a contact name to open a chat window. Enter your
message in the text entry area at the bottom of the
screen, or tap My Text to enter a preset message, and
tap Send. To invite another contact to a multi user chat,
in the Tools menu, tap Invite and tap the contact you
want to invite.

73 |MSN Messenger £ 1:56 @

You are chatting with: Adam

|| his picture will be updated In the next version.

Hi, Can you meset at 23007 Send Tap to send
message.

123[1[2[3]4]s]6][7[8[9]o]-|=[«

Tablalwle]rt]y[ufilo[p[I]]

CAP[als d[flalh[i [k[I[:]"]
!

shitt] z [x[c[v][b[n[m],[.[7]
ctlad - [ ] [+]t]<]-=
Tools Chats My Text % n

Note: To switch back to the main window without closing a
chat, tap the Contacts button. To revert back to your
chat window, tap Chats and select the person whom
you were chatting with.

Y-\
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¥ |MSN Messenger £ 1:57 @

You are chatting with: Adam
Kim Akers says:
Hi. Canywou meet at 2:007

View full chat.

|| his picture will be updated In the next version. |
|tiErll:l

View status of the

f.&\dam I5 tYping & message.
chat

1231 [2[3]4|s]a[7[8]g]0]- =]+
Tabja[wle[r[t][y[ulifa[p[l
CAP[a[s[d[f]a[h[i[k]I[:["

shittz[=[c[v[b[n[m].]. /]
ctlaal " [4] [+[t]=]=
Tools Chats M','Teul:‘i l

To know if the contact you are chatting with is
responding, look for the message under the text entry
area.

For more information on using MSN Messenger, tap
Start — Help.
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=2 jMMS

jMMS is a Multimedia Message Service (MMS). In
addition to the familiar text content of text messages,
multimedia messages can contain images, voice and
audio clips. MMS is sent as a multimedia presentation in
a single entry, not as a text file with attachments.

Using this MMS feature, you can receive and send
multimedia messages that contain images, such as
photos or graphics you've downloaded from the
Internet.

jMMS provides support for email addressing, so that
messages can be sent from phone to email and vice
versa.

This function is available only if it's supported by your
service provider. Only phones that offer the MMS
features can receive and display the multimedia
messages.
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Tap to open
Inbox where the
messages are

Tap to send a
picture message.

Opening jMMS
From the Start menu, tap Programs —» jMMS.

The jMMS main screen displays the number of new
messages, total messages, images, and tunes saved on
the Pocket PC Phone.

Tap to send a
template.

stored.

Tap to send an
audio clip.

MMS Edit Tools Yiew Help E|A
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Sending Picture Messages

You can send a picture message including a photo or
image stored in your device. You can create or edit an
image and send it as your message.

Composing an Image Message

1. On the jMMS home screen, tap Send Image. You can
also access by tapping MMS —» Compose —~ Image at
the bottom of the screen.

Thumbnails of recently used images are displayed.

ages = Y 42839 9

[T ]

Bk A
3
I

[H

G211 Showsorhides
MMS Edit Tools Yiew Help =R Egg help at the

2. Tap the image you want to send.

o Tap && to view the entire list of used images.
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e To open an image saved in another folder or in another
file format, tap gz and specify the folder or the image
type.

* You can create an image by tapping & . A new
window opens where you can create a signature or
any drawing of your choice.

Create anImage Y =% 1:23 e

&
A
O
O
-2
>
i
¢CRA=HEy =R B

MMS Edit Tools View Help E|A

3. On the text box, enter your text message by opening
the Input Panel.

If you want to preview the picture message you created,

tap [kl

4. When finished composing the message, tap Z.

5. In the Send MMS window, enter the recipient’s address
and subject. Tap Option if you want to change the
message options.
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6. Tap B> to send the message.

Creating Doodles

You can create a signature or any drawing of your
choice. New doodles can be created and sent as an
image message.

1. On the jMMS home screen, tap MMS —~ Compose
Doodles at the bottom of the screen.

2. Create a doodle using the doodle editing tools.

.)_r?j Create anImage Y =% 1:23 9

Sets the thickness of the lines drawn. —;
Drawing tool @
Erases a selection. L
Selects an area. L
Adds text. A
]
O
Sets a color to the drawing. yoei
Inserts an image.
Sends the created image. T2
e
S AEHE| Y B2A

MMs Edit Tools View Help E|A

3. Tap [& to save. The doodle cannot be saved as a
template. It can be saved in the Drafts folder and sent
later. It can be sent directly as a message.

4. To send a message using this drawing, tap .

You are asked to enter a text message and then enter the
recipient’s address. See page xx.
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Composing an Audio Message

Audio files can be attached to messages or sent as a
message.

1. On the jMMS home screen, tap Send Tune. The
recently used audio files are displayed.

2. Tap the audio file you want to send.

2
]

[T1

ASITELEY I

MMS Edit Tools Yiew Help E

.

e Tap &4 to view the complete list of used audio files.

¢ To select another audio file saved in your Pocket PC
Phone, tap [= . Browse and select an audio file.

o Tap " to create a new tune. Tap # to start recording
a voice or music and then tap @ to stop. To save it,
tap . The tune is automatically saved as a .wav file.
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3. When you select an audio file, the selected file plays.
Tap B8 and enter your text message in the text box.

If you want to insert an image in the audio message, tap
and select the image.

If you want to preview the message, tap ).
4. When finished composing the audio message, tap Zv.

5. In the Send MMS window, enter the recipient’s address
and subject. Tap Option if you want to change the
message options.

6. Tap 2 to send the message.

Creating a Message Template/mCard

mCards are templates containing text, audio and/or
video contents. mCards can be used for affixing your
signature as an image, adding your email or postal
address, adding telephone numbers or text signature as
text, or for attaching a voice message. They can be
customized according to your requirements and sent as
a message.

To create a message template/mCard:

1. On the jMMS home screen, tap Send mCard. You can
also access by tapping MMS —» Compose > Template
at the bottom of the screen. A list of pre-defined
templates are displayed.
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2. In the Select Template window, tap |ﬂ,j A new blank
page is displayed.

‘.;ﬂ_r.w;' Advanced Compose Yy, 4% 1:18 o

_ 5. and then???? To save, how????

To send a message using an mCard or template:

Note: An mCard can have a maximum of seven slides. A slide
can have a text, image, and/or audio.

[This picture will be updated In the next version. 1. On the jMMS home screen, tap Send mCard. You can

also access by tapping MMS —~ Compose —~ Template
at the bottom of the screen. A list of pre-defined
templates are displayed.

= = Select Template G639
AT

MMS Edit Tools Yiew Help E|A

3. Create a template message: r .
Eal . . - Message
e Tap [&l to insert an image. St t !

|| his picture will be updated In the next version.

e Tap A to enter text.

e Tap #]% to insert an audio file.

Note: Each page is displayed as one screen on the receiver’s
device. 4 &3

MmMs Edit Tools ¥iew Help

4. A message can have more than one page. To add more
pages, tap B .
Each page can contain only one instance of text, audio

and image. Use the next and previous buttons to
navigate between pages.
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2. In the Select Template screen, tap a template you want

to send. The selected template displays in the next
window.

L] Select Template

S~

|v

|| his picture will be updated In the next version.

[ ]

& | B ! - -

mMMs Edit Tools Yiew Help

. Tap 4d if you want to edit the image, audio and text

contents of the template.

. Tap % to specify the recipient's address and subject.

If you want to set the message options, tap Options.
The default options are used if you do not specify any
options.

5. Tap % to send the message.
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Receiving Multimedia Messages

Inbox

When a new multimedia message comes in, the
message is stored in the jMMS Inbox.

When you access the Inbox, the list of multimedia
messages are displayed with the information about the
sender and subject. In the Detailed view mode, the
received date and expiry time of the message are
displayed.

il M2 Now 2:15n

Inboz: | |Simpie -

i [ subect [se= |
Ty 3721

; Flag fiying high
. MMS 7.
P’ sajulp... Thank youlll 16

|| his picture will be updated In the next version.

Ferzona Mesage
Em Taag ciping s saubn@iatagyLsoft

LCam

@B BE B F T

MMS Edit Tools Yiew Help

The messages can be sorted in any of the fields
displayed, by clicking on the corresponding column
head.



Message, Internet and Messanger

Reading Messages

Before reading, the messages have to be first
downloaded to your Pocket PC Phone.

To read a message:

1.

On the jJMMS home screen, tap Inbox. The messages in
the Inbox are displayed.

. Tap E to download the message if not downloaded (a

must??? or to refresh???).

Select the message you want to read. The preview of
the message is displayed in the Preview Pane.

While you read the message, you can use the following
options:
¢ To play the message in the full view, tap E

e To navigate through the Inbox, select Previous
Message or Next Message from the View menu.

« To view the message properties, tap [-Z].

The Message Property window displays the sender’s
address and details of the objects in the message,
such as the media file name, size, and type.

To save the objects, select the object from the Object
Present group and tap Save.
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. After you read a message, you can use the following

options:
e To reply, tap ¢, or tap MMS — Reply.

e To reply to all the recipients, tap 4, or tap MMS —
Reply All.

¢ To move the message to a selected folder, tap Pﬁ, or
tap Tools ~ Move to Folder.

¢ To forward the message, tap 'gﬁ, or select MMS
Forward.

« To delete the message, tap /&]. The message is moved
to the Deleted Items folder.
To retrieve the message, move the message back from
the Deleted Items folder.
To delete the message permanently, select it in the
Deleted Items folder and then tap &.

e To mark the message as read or unread, tap View —
Mark as Read or Mark as Unread.

e To add the sender's address to Addressbook, tap £&
in the message list view.
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Configuring the jMMS Settings

Managing Folders

e To view the existing folders, tap View — Folder.

e To create a new folder, tap View — Folder ~ New
Folder.

e To delete a folder, tap View — Folder — Delete Folder.

Note: System folders such as Inbox cannot be deleted.

Arranging Incoming Messages

Messages can be arranged efficiently by using the
message rules. Incoming messages can be
automatically moved to different folders, deleted, or
marked as read or unread.

These operations can be done based on the message
size, recipient's address, subject and/or message class.

To create a new rule:

1. Tap View —~ Message Rules.
2. In the Filter Options window, tap New.
3. Specify the settings in the Filter and Conditions tabs.

4. Tap to apply the settings.

Message, Internet and Messanger

On the Filter Options screen, you can set the message
rule to sort the message rules according to what you
want, using the Up and Down options. The order of the
list defines the precedence. The message rule that is
placed at the top of the list gets maximum precedence.
When a new rule is created it is added to the bottom of
the list.

To set the priority for a rule:

1. Tap View —~ Message Rules.

2. In the Filter Options window, select the rule from the list
and then tap Up or Down in the Priority group.

3. Tap to apply the settings.

®" Wireless Village

Data is required!!!
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Microsoft® Pocket Outlook includes Calendar, Contacts,
Tasks, Inbox, and Notes. You can use these programs
individually or together. For example, e-mail addresses
stored in Contacts can be used to address e-mail
messages in Inbox.

Using ActiveSync®, you can synchronize information in
Microsoft Outlook or Microsoft Exchange on your PC with
your device. You can also synchronize this information
directly with a Microsoft Exchange server. Each time you
synchronize, ActiveSync compares the changes you
made on your device and PC or server and updates both
PC with the latest information. For information on using
ActiveSync, see “ActiveSync Help” on the PC.

You can switch to any of these programs by tapping on
them in the Start menu.

®" Calendar

Use Calendar to schedule appointments, including
meetings and other events. You can check your
appointments in one of several views (Agenda, Day,
Week, Month, and Year) and easily switch views by using
the icons on the command bar.

Scheduler

‘.f:_r?"i" Calendar Y o a:54 9

sep03, 03 sMT[TFs B i1+ —— Tap to go to today.
Tap to display or edit
;Iggptl;gaop Zr;eéa?lz?ointment

12:00p-1:00p

New Tools B E @ E|‘

Tap to create a new appointment.

Note: You can customize the Calendar display, such as
changing the first day of the week, by tapping Options
on the Tools menu.

Looking at Your Calendar

By default, the Calendar first appears in the Agenda
view, which provides the most detail about your
appointment.

From the Start menu, tap Calendar.
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Creating an Appointment

1. If you are in Day or Week view, tap the desired date and

time for the appointment.

2. Tap New.

Tap to return to the calendar
(the appointment is saved
automatically.

..{a,r».i'j-‘ Calendar Y ofa:54 O
Subject: || - Tap to choose from

R = predefined text.
ocation: | Tap to choose from
Starts: 9/3/03  1200PM ¥ previously entered

Ends: 9/3/03 1:00 P M locations. )
Type: Mofrmal L Tap to select a time.

Tap to select a date.
Occurs: ONce

Reminder: Remind me
15 minuteds)
Categories; MO Categories...
Appointrment | Maotes | Notes is a good
23[1][2[2]4]a]6l7]8][0]0]- p!ace'formapsand
Tab[a[w[e [r [t[¥ [u]i|o]p directions.
caPla[s[d[f[a[n]iJk]I]:]"
shift[z[z [c[v[b[n[m],[.]
ctlain] - [\ ] [L]1

Edit l

|1l

iasEr

3. Tap first to select the field.

Using the input panel, enter a description and a
location.

4. If needed, tap the date and time to change them.

5. Enter other desired information. You will need to hide

the input panel to see all available fields.
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6. To add notes, tap the Notes tab. You can enter text,
draw, or create a recording. For more information on
creating notes, see Notes: Capturing Thoughts and
Ideas later in this chapter.

7. When finished, tap to return to the calendar.

Note: If you select Remind me in an appointment, your

device will remind you according to the options set in
Start > Settings > Personal tab > Sounds &
Notifications.

Using the Summary Screen

When you tap an appointment in Calendar, a summary
screen is displayed. To change the appointment, tap

Edit.

7% |Calendar Y +f a:56 @
Lunch with ¥S Fis

12:00p-1:00p Wed, 9/3/2003 — View appointment
Pizza hut details.
Edit Tools E|A

Tap to change
appointment.
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Creating Meeting Requests

You can use Calendar to set up meetings with users of
Outlook or Pocket Outlook. The meeting request will be
created automatically and sent either when you
synchronize Inbox or when you connect to your e-mail
server. Indicate how you want meeting requests sent by
tapping Tools ~ Options. If you send and receive e-mail
messages through ActiveSync, select ActiveSync.

Scheduling a Meeting

1. Create an appointment.

fj Calendar Y o 1221 @
Subject: ||

Location:
Starts: 5/22/03 12:00 PM
Ends: 5/=2/03 1:00 P
Type: Mormal
Occurs: ONCE
Reminder: Remind me
15 minute(s)
Cateqories; MO Cateqories...
Appointrment | Motes

A0 41 4] 4

13[1]2[3|4][s[a][7[8]9]0]-[=][«
Tabla[wle[r[t[y[uli[o[p[[]]
caPla[s[d[f[o[n[i[k[1];]"]
shift[z[x[c[v[b[n[m[, [.[/]+
chfai] " [A] [+]t]<]~=
Edit H

2. In the appointment details, hide the input panel, and
then tap Attendees.
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3. From the list of e-mail addresses you've entered in
Contacts, select the meeting attendees.

4. The meeting notice is created automatically and placed
in the Outbox folder.

For more information on sending and receiving meeting
requests, see “Calendar Help and Inbox Help” on the
device.

Deleting an Appointment

Note: Tap and hold an appointment and choose Delete
Appointment from the pop-up menu to delete an
appointment.

1. From the Start menu, tap Calendar.
2. Tap an appointment to view it.

3. Tap Tools.

4. Tap Delete Appointment.

5. Tap Yes to permanently delete the appointment.
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Contacts

Contacts maintains a list of your friends and colleagues
so that you can easily find the information you're
looking for, whether you’re at home or on the road.
Using the device’s infrared (IR) port, you can quickly
share Contacts information with other device users.

Note: To change the way information is displayed in the list,
tap Tools and then Options.

Creating a Contact

1. From the Start menu, tap Contacts.

‘.{Ei’j" Contacts Y %1227 h
Marne: M

Job title:

2. Tap New.

[m T»

Department:

Company:

Work bel:

Wark Fas:
Work addr: v

E-mail:

Modbile tel:

Details Notes|

1231 [2[3[4]5][6][7[8][o]0]-[=[«
Tabla[wle[r[t[y[uli[o[p|[]]
cap[afs[d[f[a[n[i[k[I[;]"

4T

shift[z [ [c[¥[b[n[m],[.[F]
ctlai] " [\ ] [+]r]<]=
Edit =g
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. Using the input panel, enter a name and other contact

information. You will need to scroll down to see all
available fields.

. To assign the contact to a category, scroll to and tap

Categories and select a category from the list. In the
contact list, you can display contacts by category.

. To add notes, tap the Notes tab. You can enter text,

draw, or create a recording. For more information about
creating notes, see Notes: Capturing Thoughts and
Ideas later in this chapter.

. When finished, tap to return to the contact list.

Viewing and Editing a Contact

1. From the Start menu, tap Contacts to display a list of

your contacts from the last category selected.

2. Tap the down arrow next to the category name to see

the list of categories.

Y <1225

Show « .

Recent i [ opg | rst |ew| xye
v #ll Contacts Be-TTI7 w
No Categories B3-4567 w
T Ao 12 3-4567 w

New Yiew Tools E| - a
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3. Tap a category name to see a list of contacts placed in
that category.

4. Tap a contact’s name.
5. Tap Edit to see the contact.

6. Edit the contact information and tap to save the
contact information and return to the list of contacts.

Deleting a Contact

Note: If you delete a contact on your Pocket PC Phone and
synchronize Contacts with your computer, you also
delete the contact in Outlook on your computer.

1. From the Start menu, tap Contacts to see a list of your
contacts from the last category selected.

2. Tap the down arrow next to the category name to see a
list of categories.

3. Tap a category name to see a list of contacts placed in
that category.

4. Tap and hold a contact’s name to see a pop-up menu.

Contacts

; Y (D606 €3
All Contacts -

#ab]cde| foh [ ik [Imn]apal rst juvw] s

Andrea 9870543678 w
Eun (345) 789-6543 m
John (087) 653-2566 w
Young (425) 345-5677 w
Save To SIM
Phonebook
Send SMS

Create Copy
Delete Contact

Send E-mail to Contact...
Beam Contact...

Call Mobile Tel -
Add Speed Dial Mobile Tel E|‘

7. Tap Yes to permanently delete the contact.

Scheduler

6. Tap Delete Contact to remove the contact from the list.
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Using the Summary Screen

When you tap a contact in the contact list, a summary
screen is displayed. To change the contact information,
tap Edit.

; Y <1000 O

Andrea

Translatar — View contact

HS details.

(095) 261-5042 wark tel

(055) 263-7522 Work Fax

lovelyiihanmal. net E-mail

011-9870-4657 Mobile tel

Summary | Motes : Tap to view notes
Edit Tools E|A

Tap to change contact information.

Notes
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Quickly capture thoughts, reminders, ideas, drawings,
and phone numbers with Notes. You can create a
written note or a recording. You can also include a
recording in a note. If a note is open when you create
the recording, it will be included in the note as an icon.
If the note list is displayed, it will be created as a stand-

alone recording.

i |Notes Y o= 4:06 9

I All Folders

Name »
Enjoy your Pocke... 3:59p ik
[_Note1 4:00 p 902b
[_Inote2 4:00 p 832b
[_]Note3 4:01 p 892b

Create Copy
Delete
Select all

Beam File...

Send via E-mail...

Rename;/Move...

o [m ] [——— [« m %

New Tools

=B

Tap to create a new

item.

Tap to change the
sort order of the list.

Tap to open a note
or play a recording.

Tap and hold to
display a pop-up
menu of actions.

Tap to record.

Tap to show or hide
the Recording toolbar.
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Creating a Note

1. From the Start menu, tap Notes.

2. Tap New.

3. Create your note by writing, drawing, typing, and/or
recording. For more information about using the input
panel, writing and drawing on the screen, and creating

f[Notes ¥ o 1:53 el

@AII Folders ~ Name ~

[_]Note1 1:50 p 848b
[,_INotez 1:52p 658b
qJ*recordingl 1:53 p 20.2s

o[n]) [ [« |m]ut

New Tools E|A

recordings, see Chapter 3.

Tasks

Select the category of tasks

Scheduler

Use Tasks to keep track of what you have to do.

you want displayed in the list.

i v O

All Tasks ~ Priority ~ ——

1! Buy birthday gift

O “caiisam

Create Copy
Delete Task

Beam Task...

New Tools E|A

Tap to create a new task.

Select the sort order of
the list.

Indicates high priority.

Tap to display or edit the
task details.

Tap and hold to display
a pop-up menu of
actions

Note: To change the way information is displayed in the list,

tap Tools and then Options.
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Creating a Task

1.

2.

7.

From the Start menu, tap New and Task.

Tap New.

. Using the input panel, enter a description.

. You can enter a start date and due date or enter other

information by first tapping the field. If the input panel
is open, you will need to hide it to see all available
fields.

. To assign the task to a category, tap Categories and

select a category from the list. In the task list, you can
display tasks by category.

. To add notes, tap the Notes tab. You can enter text,

draw, or create a recording. For more information on
creating notes, see Notes: Capturing Thoughts and
Ideas later in this chapter.

When finished, tap to return to the task list.

Note: To quickly create a task with only a subject, tap Entry
Bar on the Tools menu. Then, tap Tap here to add

a new task and enter your task information.

Scheduler

Viewing and Editing a Task

1. From the Start menu, tap New and Task.

The Tasks list displays.

2. Select the list you want by tapping it.

Y 4¢234 @
Priority -

[]! Buy
New Tools E|A

If the list is assigned to a certain category, tap the down
arrow next to All Tasks and select the category. When
the list(s) in the category displays, select the list you
want by tapping it.

3. The screen shows the details of the task list.
4. Tap Edit to see the task.

5. Edit the task information and tap to save the task
information and return to the list of tasks.
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Deleting a Task

Note: Tap and hold a task and choose Delete Task from the
pop-up menu to delete a task.

1. From the Start menu, tap New and Task.

2. Tap and hold the task you want to delete and tap Delete
Task.

. Y «f 235 B4
All Tasks ~ Priority

| ' | ik || Tap here to add a new task |
]! Buy

New Tools E|A

3. Tap Yes to permanently delete the task.

Scheduler

Using the Summary Screen

When you tap on a task in the task list, a summary
screen is displayed. To change the task, tap Edit.

Y ¢ 1005 (O
e
View task details.
Starts: a/a/2003
Cue: 9f2/2003
Categories: Business . Tap to show and hide
additional summary
information.
View task details.
Edit Tools E|A

\— Tap to change task.
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Camera

With the built in camera on your Pocket PC Phone, you
can take pictures of people or events while on the move.
You can view and edit photos and send them to your
friends in a multimedia message. Your Pocket PC Phone
supports JPEG, GIF, PNG and BMP picture

Taking Pictures

1. From the Start menu, tap Camera.

On the Capture screen, you can view the image to be
captured.

Showsthe —M8M —— ————— Sho_ws the
ovllalespace i I EEEREC S RACCTITREY 2220
SD card, if 8 Capt s space in the
inserted. = SRR main memory.

Adjusts the
brightness of
image.

Tap to take a

Zooms in or out .
picture.

of an image.

L= Goes to Photo
‘ Edit.

Goes to Photo Album.

Multimedia

2. Locate the image you want by rotating the camera
module and aiming it to the subject.

Camera module —%-% @’@*

3. Use & and & to adjust the brightness of the image.
Tap 4} and i} to zoom in or out of the image.

To rotate the image as a mirror image, tap E

4. Tap Shutter to take a picture. The taken picture
displays on the preview screen.
Rotates the photo image.

amera Manager Y ol 8:27 °

WGl Frevisw = @) B cancels saving.

Saves the
photo in Photo
Album.

Goes to the

. =
@ & Capture mode.

&
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5. To save a picture, tap B, enter a name, and then tap
Save. The picture is saved in Photo Album. See page
XX.

If you are not satisfied with the photo, tap @ When a
confirming message displays, tap Cancel.

6. After saving the photo, you are asked to send the photo
to MMS. Tap Yes to send the photo in a multimedia
message.

7. Repeat steps 1 through 6 to take more photos.

Using the Timer

You can set the camera to take a photo automatically
after 10 seconds.

1. In the Capture mode, tap [Zifgzez].

2. When you are ready to take a photo, tap Shutter.
You can also use this feature by tapping -
Recording method — 10 second delay.

3. After 10 seconds, a photo is taken and displayed on the
Preview screen.

Taking Action Shots

You can take a sequence of three pictures of a moving
subject.

To take action shots:

1. In the Capture mode, tap the box at the top right of the
screen and select Continuous Capture.

You can also activate this feature by tapping -
Recording method —» Continuous capture.

Multimedia

2. When you are ready to take a picture, tap Shutter. The
camera takes the action shots.

Setting the Camera Options

You can customize the camera settings.

1. On the Capture screen, tap @ at the bottom of the
screen.

2. Adjust any of the following settings:

e Shutter sound: determines whether a tone sounds
when you tap Shutter.

¢ Insert date: stamps the photo with the time and date
of when the photo was taken.

e Capture: adjusts the exposure settings based on the
lighting conditions. You can select Auto, Indoor,
Outdoor, or Night.

e Insert date to image: displays the time and date a
photo was taken next to the image name in Photo
Album.

e Compression rate: determines the image
compression rate. The lower the rate is, the more
memory the image consumes and the higher the
image quality.

3. Tap (8.
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Photo Album

In Photo Album, you can view, delete, and send photos
stored in your Pocket PC Phone. You can also set a photo
as a background image of your Pocket PC Phone.

Photo Album allows you to view photos in Thumbnail
view. Thumbnail view displays miniature versions of
your photos so that you can see several photos on the
screen at the same time. Use this view to browse
through photos or to locate a photo quickly.

Viewing Photos

1. In Camera, tap @ at the bottom of the screen to open
Photo Album.

2. To open photos stored in another folder, select the folder
in the drop down arrow box.

3. You can view the photos you have taken.

To view the photos in Thumbnail view, tap at the top
of the screen. To return to a single full view, tap [%] at
the top of the screen.

4. The photo displays with:

¢ the file name, time and date when it was taken or
saved.

e the number of images inside the current folder.

Multimedia

Tap to view the
slide show.

amera Manager Y ‘

£ Photo album ¥ © - Tap to delete

‘. the picture.
S Tap to set the
picture as
wallpaper.

Selects the
folder and stores
the image you
want to view. | @ &f

Thanks/2003.06.01 5:00 AM
—— &l forders

5. To view the next or previous photo, tap o or .

You can sort the photos by name or date. Tap @ and
select one from the Sort type box.

Viewing a Slide Show

A slide show is a sequential presentation of each of the
photos in the current album. You can set the length of
time each photo remains on the screen.

To view a slide show, tap G at the top of the Photo
Album screen.

To adjust the length of time each photo remains on the
screen, stop the slide show, and tap [a] in Photo Album.

In the Time interval box, select the time, and then tap

&
Y-\
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Deleting a Photo

In Photo Album, select the photo you want to delete,
and then tap @ at the top of the screen.

Editing Photos

In Photo Edit, you can edit the photos using general
editing tools.

1. In Camera, tap £ at the bottom of the screen to open
Photo Edit.

Tap to adjust the image size.

Camera Manager Y X 8:35 @

@ Photo Edit Q& EFHE — Changes the
E 0

save options.
ar

Opens a photo in
a different folder.

Editing
tools

Sets the image as

& Undo | [ Revert | | [ Wallpaper ; — a background
B @ 3 image of your
device.

2. Adjust the photo image using the editing tools. Using
the navigator, you can quickly locate a portion of the
image you want to edit.

Multimedia

3. On the Photo Edit screen, you can use the following
options by tapping .
e Open: allows you to find a picture saved as a different
type or in the different folder.

e Rename: allows you to change the saved setting
according to your prefer. You can rename the photo,
specify the category, the photo file format, and the
location to where the photo is saved.

e Undo: cancels the last edit function performed.
e To first: returns to the original status of the picture.

e Open: allows you to find a picture saved as a different
type or in a different folder.
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® Windows Media Player

Microsoft Windows Media Player for Pocket PC is easy to
use; the controls are similar to the buttons on a
compact disc player.

Use Windows Media Player on your PC to copy digital
audio and video files to your Pocket PC. You can play
Windows Media and MP3 files on your Pocket PC.

To switch to Windows Media Player:
From the Start menu, tap Windows Media.

Tap to set the
volume type from
On, Vibrate and
5 Off.

#18|windows Media Y o{x 8:39 e

a - Microsoft Corp, -

Indicates the
progress of the
current track.

>N Tap to adjust
volume.
Tap to Sel:ct Tiols
adjust Tap to skip to
volume. Tap to stop. the next song.
Tap to play a

previous song.
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Playing files

You can play any music or video files stored on your
Pocket PC Phone or on a network.

To play a file stored on your Pocket PC Phone:
1. Tap Select.

2. If necessary, in the drop-down list box, tap the Playlist
name.

3. Tap the item that you want to play, and then tap .

To play a file on a network:
1. Tap Tools ~ Open URL.

2. Enter a URL.

Note: To play streaming media, you must be connected to a
network. For more information on creating a remote
connection between your portable Pocket PC Phone and
a network, see Pocket PC Connection Help.

To play an item in web favorites:
1. Tap Select.
2. In the drop-down list box, tap Web Favorites.

3. Tap the name of the item you want to play, and then tap

>

Note: Tap and hold an item in Web Favorites to see a list of

actions you can perform.



Multimedia Multimedia

To play a file from any specific point in the file: Using the Playlist
1. Play a file. A playlist is a customized list of audio or video files that
you can arrange however you want. The first time you
2. Drag the slider below the screen to the point where you start Windows Media Player, two default playlists are
want the file to play. created: Local Content and Web Favorites.

_ _ _ Local Content lists all the audio and video files found on

Note: The amount of time a file has played appears next to its your Pocket PC and storage card. Web Favorites lists
name on the Windows Media Player screen. your favorite streaming media files.

To create a playlist:
Using the Tools menu

1. Tap Select.
You can change the appearance of the Player, play a
playlist again, shuffle items in a playlist, or configure 2. In the drop-down list box, tap Organize Playlists.
audio and video settings by using the commands on the
Tools menu. 3. Tap New, and then enter a playlist name.

To access the commands in the following options, tap

4. Tap the box next to each item you want included in the
Tools.

playlist.
About: views information about the Player.
Settings: adjusts various Player options. To edit a playlist:
Properties: views information about the currently 1. Tap Select.

playing file.
2. If necessary, in the drop-down list box, tap Playlist

Open URL: plays a streaming media file on a network. hame

Add Web Favorite: adds a streaming media file that is
currently playing to Web Favorites.

Repeat: repeats a playlist.

Shuffle: plays items in a playlist in random order.
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3. On the playlist screen, tap any of the following:

713 |windows Media Y wxs41 O

1 Local Content

# Welcome To Windows Media

shows the
properties
Moves the information about
selected item | the selected item.
up or down. ‘
Selects items on the_df % & & O =
A_It_jd Ctﬁntsnt screte:. L Plays the
ap the box next to Moves the selected item.

each item you want

included in the playlist. selected item up.

Deletes the
selected item.

To rename a playlist:

1. Tap Select.
2. In the drop-down list box, tap Oraganize Playlists.
3. Tap playlist name -~ Rename.

4. Enter a new playlist name.

Note: Tap and hold a playlist to see a list of actions you can

perform.

Multimedia

To delete a playlist:

1. Tap Select.

2. In the drop-down list box, tap Oraganize Playlists.
3. Tap playlist name — Delete.

4. Tap Yes to permanently delete the playlist.

Changing Audio and Video Setting

% | Windows Media Y sxs41

Audio

While using another program:

Video

FPlay video in full screen:

|Never -

[ shwink ta Fit in windaw
[] rotate 180 degrees in full screen

E|A
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To play Video in full screen:

1. Tap Tools — Settings ~ Audio & Video.

2. In the drop-down list box under Play video in full
screen, tap one of the following settings:

e Never: never plays video in full screen.

¢ Only when oversized: plays only oversized video in
full screen.

e Always: plays all video files larger than the video
area of a skin (typically, 240x176).

To rotate video 180 degrees when played in full screen,
select the Rotate 180 degrees in full screen check
box.

Multimedia

®. Games

Pocket PC Solitaire is installed in the Games folder. To open
the solitaire game, from the Start menu, tap Programs —
Games — Solitaire. The game starts.

Time: 0 Score: 0

New Tools « E|A

When you want to restart the game, tap New and to
stop the game, tap X.

You can set the game options by tapping Options in the
Tools.
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The number stored ! 0./« — Clears the last
in your memory is D' number you
displayed. entered.

Programs

®" Calculator

The calculator allows you to perform general
mathematical functions, such as addition, subtraction,
multiplication, and division.

You can use the calculator to:

e perform basic calculations.

e store and retrieve values.

e display the last series of calculations.

To open the Calculator:

1. From the Start menu, tap Programs — Calculator.

(ko)
@)
)
(@)
©)

@E®OE
OP@®QW
O@@©®
' [0I0006G)

Edit
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Using the Calculator

The calculator includes several buttons to complete the
mathematical calculations.

e CE - The “"CE” button clears the last number you
entered. Use this button if you make a mistake while
entering a number in the middle of a calculation. This
button enables you to re-enter the nhumber without
starting the calculation over.

e C - The “C” button clears the entire calculation and
enables you to begin a fresh calculation.

e +/- - The “Plus/Minus” button toggles the current
number between a negative and positive value. If you
want to enter a negative number, enter the number
first and then press the +/- button.

e M+ - The "M+" button places the current number in
memory. Each new number you enter with the M+
button is added to the total stored in memory. The
number that you add can be either a calculated value
or any number you enter by pressing the number
buttons. Pressing this button has no effect on the
current calculation (or series of calculations); it
merely places the value into memory until it is
recalled.

e MR - The "MR” button recalls the stored value from
memory and inserts it in the current calculation.

e MC - The "MC” button clears any value that is stored
in the Calculator memory.
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2% Microsoft Reader

Use Microsoft Reader to read e-Books on your Pocket PC
Phone. Download books to your PC from your favorite e-
Book Web site. Then, use ActiveSync to copy the book
files to your activated Pocket PC Phone. The books
appear in the MS-Reader Library, where you can tap
them in the list to open them.

Each book consists of a cover page, an optional table of
contents, and the pages of the book. You can:

e page through the book by using the Up/Down control
on your Pocket PC Phone or by tapping the page
number on each page.

e annotate the book by highlighting, using bookmarks,
notes, and drawings.

e search for text and look up definitions for words.

The Guide-book contains all the information you'll need
to use the software. To open the Guide-book, tap Help
on the Reader command bar. Or, on a book page, tap
and hold on the book title, and then tap Help on the
pop-up menu.

Activating Microsoft Reader

Activate Microsoft Reader to copy protected eBooks.

1. Connect your Pocket PC to your computer.
2. Open Internet Explorer on your computer.

3. Go to <http://das.microsoft.com/activate>.

Programs

Reading an eBook

Read your eBook from start to finish or select specific
topics. If you close your eBook and later want to open it,
your ebook will open on the last page you read.

1. From the Start menu, tap Programs — Microsoft
Reader.

fii-l:;l‘ Microsoft Reader

il 46 455 €

Encarta® Pocket
Dictionary

Goto

Bloomsbury Publishing Plc

|| his picture will be updated In the next version.

Library

Shop

Help

S5ettings
sting Loockup Definition...

Return
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2. Tap the title of your eBook.

Page 1 Tap to scroll
through the
Library list.

Library

Tap to select

The Best American Shork Stories
a sort order. — g

The Ghost Writer
The Hundred searet senses  —— 18P tO open a

Tap to specify outangar book.

the books you
want to display
in the list.

Suger Plum Dead
Another World
Winter of the Welf Maon

|| his picture will be updated In the next version.

Passage o Juneau

[
Tap here to
navigate to
other parts
of the Reader.

Of Love and Other Demons

stranger in a Strange Land

3. Tap the page number or left and right arrows to move
backwards and forwards in the book.

Note: To jump to a topic, tap a link. Links can occur
throughout the text or table of contents. To return from
a link, tap the title of the eBook and tap Return.
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Using the Library

The Library is your Reader home page; it displays a list
of all the books stored on your Pocket PC Phone or
storage card.

To open the Library:
e On the Reader command bar, tap Library.

e On a book page, tap the book title, and then tap
Library on the pop-up menu.

To open a book:
e Tap its title in the Library list.

®" Pocket Excel

Pocket Excel works with Microsoft Excel on your PC to
give you easy access to copies of your workbooks. You
can create new workbooks on your Pocket PC Phone, or
you can copy workbooks from your PC to your Pocket PC
Phone. Synchronize workbooks between your PC and
your Pocket PC Phone so that you have the most up-to-
date contents in both locations.

Use Pocket Excel to create workbooks, such as expense
reports and mileage logs. To create a new file, tap Start
- Programs — Pocket Excel >~ New. A blank workbook
appears. Or, if you've selected a template for new
workbooks in the Options dialog box of the Tools, that
template appears with appropriate text and formatting
already provided. You can open only one workbook at a
time; when you open a second workbook, you'll be
asked to save the first. You can save a workbook you
create or edit in a variety of formats, including Pocket

Excel (.pxl) and Excel (.xls).
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Pocket Excel contains a list of the files stored on your Using Workbook

Pocket PC Phone. Tap a file in the list to open it. To

delete a file, make copies of a file, or send a file, tap and 1. From the Start menu, tap Programs — Pocket Excel.
hold the file in the list. Then select the appropriate

action from the pop-up menu. Pocket Excel provides 2. Tap New to create a new workbook. You'll see either a
fundamental spreadsheet tools, such as formulas, blank workbook or template, depending on what you‘ve
functions, sorting, and filtering. To display the toolbar, selected in the Options dialog box.

tap View — Toolbar.

‘.{Eﬁ’j" Pocket Excel Y % 2:50 @

Note: If your workbook contains sensitive information, you a1
can protect it with a password. To do so, open the A [ B [ ¢ [F
1 =

workbook; tap Edit ~ Password. Every time you
open the workbook, you will need to enter the
password, so choose one that is easy for you to
remember but hard for others to guess.

[T
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] | v ]
Ready |Shestl w |[Sum=0D -
1231]2[3[4]|s5|e|7[8[a]0]- -]«
TablaJwle[rt]y[uli[o[p|[]]
capla[s[d[flg[h]j[k[1[:]"

shift{ z[x [c[v[b[n[m[, [. [/
cfai] " [\ ] [4Tt]
New Edit ¥iew Format Tools T H

+!

(—|—)

3. Select a cell. If the cell is not visible, tap Tools ~ Go
To. Type the reference (example:A4) and tap OK.

4. Type the value or text using the input panel button and
tap 4~ in the input panel.

5. Text is automatically aligned to the left.

6. You can edit and format data by tapping Edit, Format
and Tools. For more details, see the on-line Help.
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7. Tap to close and save the workbook.

The workbook is automatically saved as a Pocket Excel
workbook named Book1. Depending on how many
workbooks you have created since opening Pocket
Excel, you may want to rename it.

Note: Pocket Excel only recognizes and displays documents in
one folder below All Folders. For example, if you
created another folder in the Personal folder in All
Folders, the documents in that folder will not be
shown.

Tips for Working in Pocket Excel

Note the following when working with large worksheets
in Pocket Excel:

e View in the Full screen mode to see as much of your
worksheet as possible. Tap View and then Full
Screen. To exit the Full screen mode, tap Full Screen
again.

e Show and hide window elements. Tap View and then
tap the elements you want to show or hide.

e Freeze panes on a worksheet. First select the cell
where you want to freeze panes. Tap View and then
Freeze Panes. You might want to freeze the top and
leftmost panes in a worksheet to keep the row and
column labels visible as you scroll through a sheet. To
exit, tap Unfreeze Panes.

e Split panes to view different areas of a large
worksheet. Tap View and then Split. Then drag the
split bar to where you want it. To remove the split, tap
View and then Remove Split.

Programs

e Show and hide rows and columns. To hide a hidden
row or column, select a cell in the row or column you
want to hide. Then tap Format, then Row or Column,
and then Hide. To show a hidden row or column, tap
Tools » Go To, and then type a reference that is in
the hidden row or column. Then tap Format ~ Row or
Column — Unhide.

®% Pocket Word

Pocket Word works with Microsoft Word on your PC to
give you easy access to copies of your documents. You
can create new documents on your Pocket PC Phone, or
you can copy documents from your PC to your Pocket PC
Phone. Synchronize documents between your PC and
your Pocket PC Phone so that you have the most up-to-
date content in both locations.

Use Pocket Word to create documents, such as letters,
meeting minutes, and trip reports.

Creating a New File

From the Start menu, tap Programs —~ Pocket Word —
New.

A blank document appears. Or, if you've selected a
template for new documents in the Options dialog box
in the Tools, that template appears with appropriate
text and formatting already provided.

You can open only one document at a time; when you
open a second document, you’ll be asked to save the
first.

Y\
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You can save a document you create or edit in a variety
of formats, including Word (.doc), Pocket Word (.psw),
Rich Text Format (.rtf), and Plain Text (.txt).

Pocket Word contains a list of the files stored on your
Pocket PC Phone. Tap a file in the list to open it.

To delete a file, make copies of a file, or send files, tap
and hold the file in the list. Then, select the appropriate
action on the pop-up menu.

Select the type of folder you want
displayed in the list.

2 &ll Folders - Name Tap to change the
) Agenda 4:08 p 420b sort order of the list.
@Homework 4:08 p 420b

Tap to open a
document.

rea l:op
Delete
Select all
Tap and hold an item
to see a pop-up
menu of actions.

Send via E-mail...
Beam File...

Rename;Move...

New Tools E|A

Tap to create a new document.
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Note: You can change the zoom magnification by tapping
View and then Zoom. Then select the percentage you
want. Select a higher percentage to enter text and a
lower one to see more of your document.
If you're opening a Word document created on a PC,
select Wrap to Window on the View menu so that
you can see the entire document.

You can enter information in Pocket Word in one of four
modes (typing, writing, drawing, and recording), which
are displayed on the View menu. Each mode has its own
toolbar, which you can show and hide by tapping the

Show/Hide Toolbar button ( t,) on the command bar.
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Typing Mode Writing Mode

Using the input panel, enter typed text into the In the Writing mode, use your stylus to write directly on
document. For more information on entering typed text, the screen. Ruled lines are displayed as a guide, and the
see Chapter 3. zoom magnification is higher than in the Typing mode to

allow you to write more easily.
Tap to return to the document
Tap and hold to see a list (changes are saved

. . Pocket Word Y o4z 413 N
pop-up menu of actions. automatically.

F

Meeting noh ks

Paste T =T o="Y B With Space button
Clear v g(uv e | selected, drag to

Format... [ insert space. An
Paragraph... P‘% AP o arrow appears

Tap to change
formatting options.

HECOOIILE

Alternates...

\V/ showing the space
direction and size.

spellcheck |———— 1P 1O =
1231]2]3]4]s][6[7[8][9]0]-[=[4« ‘ n selected text.
Tab[a[w[e[r[t][¥[ulilo]p|L[] NewEdlth:wToos E|A
cap[afsfd[flofh[j[k][I]]"] Space button 1ap to select
shift[2[x [c[v[b[n]m[, [.[/] < formatting options,
ctfai] " [\] [+]1]<]= Pen button h iaht
New Edit ¥iew ToolsE n suc _as pen weig

and line color.
Tap to show or hide For more information on writing and selecting writing,
the toolbar. see Chapter 3.

To format existing text and/or to edit text, first select
the text. You can select text as you do in a MS-Word
document, using your stylus instead of the mouse to
drag through the text you want to select. You can search
for a document by tapping Edit and then Find/
Replace.

Note: If you cross three ruled lines in a single stylus stroke,
the writing becomes a drawing, and can be edited and
manipulated as described in the following section.
Written words are converted to graphics (metafiles)
when a Pocket Word document is converted to a Word
document on your PC.

A A
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Drawing Mode

In the Drawing mode, use your stylus to draw on the
screen. Gridlines appear as a guide. When you lift your
stylus off the screen after the first stroke, you'll see a
drawing box indicating the boundaries of the drawing.
Every subsequent stroke within or touching the drawing
box becomes part of the drawing. For more information
on drawing and selecting drawings, see Chapter 3.

Y % 1:50 QI
Drawrin
S BRI
Format... ; Resize an object by
Cut / : — dragging the
Y /‘ : selection handles.
Copy H
CreatecCopy || |77
Group
Ungroup
Align... [+
Shape... pls *, E|‘
L Tap to select formatting
Select Shape on options, such as line
the pop-up menu to weight, fill color, and
convert objects to line color.
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Recording Mode

In the Recording mode, embed a recording into your
document. For more information on recording, see
“Recording a Message” in Chapter 3.

For more information on using Pocket Word, tap Start
and then Help.

Changing the Options

To change defaults for creating and storing Pocket Word
documents, in the document list, tap Tools —~ Options.

e Select a template to be used for new documents. You
can change this default when creating specific
documents. Only documents saved in the Templates
folder are listed.

e Select a location for storing documents. You can
choose between main memory and a storage card, if
you have one installed.

e Select the type of documents you want displayed in
the document list.
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®% SIM Contacts

When switching SIM cards between devices, use SIM
Contacts to copy contacts from a new SIM card to
Contacts on your Pocket PC Phone.

To copy a contact to your SIM card:

1. From the Start menu, tap Programs > SIM

Contacts. Your phone reads the SIM contacts. To
cancel, tap Cancel.

Y 4% 2:56

To copy your SIM contacts to
Contacts, tap "Copy Mow", Only new
contacts will be copied.
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2. Select the contact you want to copy to your Pocket PC
Phone and tap Copy Now.

#7% |SIM Contacts

Y 4:258 QO

To copy your SIM contacts to
Contacts, tap "Copy Mowe", Only new
contacts will be copied.

SIM Contacts:

AD 123
] 0166635297
=] 2555

Copy Now

E|A

3. To verify that your contacts have been copied to your
Pocket PC Phone, switch to Contacts and search for the
added contacts. For more information on using

Contacts, see page xx.

To transfer a number to Speed Dial:

1. Press &], the left side of the navigation pad or Speed

Dial > New.

2. Find the contact you want to add, and then press the
center of the navigation pad.

A
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3. When the contact name and number appears in the To add a record from Call Log to Microsoft Contacts:
screen, select an available location using the arrow
keys. 1. Press &], and then the right side of the navigation
pad.
flphone ¥ qz2r Q) 2. Find the call details by first selecting the category it is
Speed Dial filed under. For example, if it is @ missed call select
Cortact: Johi Fradericks Missed from the drop-down menu in the top-left corner.
¥ ! i
e [ohn Freder s | 3. Press and hold the center of the navigation pad; in the
Number: [0287875599 w | pop-up menu that appears select New Contact.

|| his picture will be updated In the next version.

all Calls ~

3

g (055) 665-85 2:28 p

(092) 706-5569 2:28 p

{N55) AR5-05
MNew Contack

=8
[This picture will be updated in the Next Version.
e 55 213 p
Note: By default the Location function will give you the next Call a5 208 |

available position in the Speed Dial list. If you want to
put a number in a position that is already occupied, the
new number will replace that number already there.

(D92) 706-5569 9/3/01
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4. In the New Contact screen add additional contact
details and press the center of the navigation pad or tap

.

5. The call details in the Call Log will then be amended
and displayed under the name of the contact, not the
telephone number.

a Y-\
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2% Terminal Services Client

Using the Terminal Services Client, you can log onto a
PC that is running Terminal Services or Remote Desktop
and use all of the programs that are available on that PC
from your Pocket PC Phone. For example, instead of
running Microsoft Pocket Word, you can run the PC
version of Microsoft Word and access all of the .doc files
on that PC from your Pocket PC Phone.

Note: You cannot use Transcriber when entering
information in Terminal Services. You must use
Keyboard, Block Recognizer, or Letter
Recognizer.

Connecting to a Terminal Server

Start a remote connection to the server via your
wireless modem connection or network (Ethernet) card.

1. From the Start menu, tap Programs — Terminal
Services Client.

2. To connect to a server you have previously connected
to, tap Recent servers, and select the server.

3. To connect to a new server, enter the server’s name in
the Server box. Select the Limit size of server
desktop to fit on this screen check box only when
using applications that have been specifically sized for
use with Pocket PC.

4. Tap Connect.
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Note: If the network administrator has configured Terminal
Services Client to reconnect to disconnected sessions,
and you previously disconnected from a Terminal
Server without ending the session, the Terminal
Services Client reconnects to that session.

Disconnecting Without Ending a Session

The following commands must be accessed from the
Start menu in the Terminal Services window used to
access the PC’s commands. Do not use the Start menu
on your Pocket PC Phone.

1. In the Terminal Services window, tap Start —
Shutdown.

2. Tap Disconnect.

Note: If the network administrator has configured Terminal
Services Client to reconnect to disconnected sessions,
you will be reconnected to this session the next time
you connect to this server.

Disconnecting and Ending a Session

1. In the Terminal Services Client window, tap Start
and then Shutdown.

2. Tap Log Off.



Programs

Navigating Within Terminal Services Client

Once connected to the server, the PC’s screen may more
than fill your phone’s screen. If scroll bars are displayed
on the server’s screen, you will see more than one set of
scroll bars on your Pocket PC Phone:

e One to scroll information on the PC, and one to scroll
the PC display through the Terminal Services window
in Terminal Services Client.

¢ To ensure you are scrolling the PC display through
Terminal Services Client, use the four directional
buttons at the bottom of the Terminal Services Client
screen.

e To better-fit information on your phone’s screen,
select Limit size of server desktop to fit on this
screen. For the best effect, programs on the PC
should be maximized.

Note: You cannot use Transcriber when entering
information in Terminal Services. You must use
Keyboard, Block Recognizer, or Letter
Recognizer.

Tips and Tricks

To improve display performance:

Display performance is improved by decreasing the time
it takes for the screen to be refreshed on the PC.

1. On your PC, select Start ~ Settings —~ Control Panel.

2. Click Display.
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3. Clear the Transition effects for menus and tooltips
check box.

To Improve browser performance:

Performance with Internet Explorer on the PC is
improved by decreasing the time it takes for Web pages
to be refreshed.

1. In Internet Explorer on your PC, select Tools
Internet Options

2. Click the Advanced tab.

3. Clear the Use smooth scrolling check box.
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®" File Explorer

The File Explorer application allows you to open an
explorer window similar to a desktop Windows based
system. The explorer window allows you to navigate
through the i700 to locate desired folders and files.

To launch the file explorer:

1. From the Start menu, tap Programs — File Explorer.

f_w" ¢ |File Explorer Y £ 244 °
My Documents » Name -
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[_INotez 5/22/03 G588
& Playlist 5/22/03 4138
&lpop 5/22/03 S04B
d|<Recordingl 5/22/03 32.1K
Edit upen|A[!] =] [

2. Tap the folder list (labeled My Document by default)
and then the folder that you want to view.

3. To open an item, tap it.

To quickly delete, rename, copy, or move an item, tap
and hold. To select multiple items, tap and drag. Then,
tap and hold the selected items. On the pop-up menu,
tap Copy, Delete, or Rename.
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Note: A I next to a file name indicates that the file is saved
on a storage card.

#= Infrared Receive

Infrared Receive or IR is used to receive and send folder,
files between two IR devices. In most cases, you can
also receive files from your PC when it is equipped with
an IR port. The two devices are aimed at each other
approximately four inches apart.

If you have difficulty getting the two devices to send or
receive information, try the following:

e Transfer only one file at a time. No more than 25
contacts should be done at once.

e Make sure that the IR port windows are clear and free
of any dirt or obstacles.

e Adjust the room lighting or move to another location.
Some types of lighting may interfere with the
transmission.

Receiving a File

1. Prepare a file from another IR device and initiate a send
command.

2. From the Start menu, tap Programs — Infrared
Receive.
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‘."'.3;' ![Infrared Receive Y £ 2:46

frared

Looking for sending device...
{Align infrared ports)
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3. Aim the two devices at each other and wait for
confirmation that the file has been received.

4. Tap Close.
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®Y Modem Link

Using Modem Link, you can use your Pocket PC Phone
as an external modem for another device or computer.
If you select Modem Link, the USB path will switch to
Modem Link.

To activate the Modem Link:

1. Connect your Pocket PC Phone to the device with which
you want to use your Pocket PC Phone as a modem.

2. From the Start menu, tap Settings » System
Modem Link.

3. Select Modem Link.

4. Tap [B8.
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Appendix A: Letter Recog-
nizer

Using Letter Recognizer, you can write characters
directly on your Pocket PC Phone screen with your
stylus, just as you would on a piece of paper. The
characters you write are translated into typed text. Use
Letter Recognizer anywhere you want to enter text, for
example, to write a note or to fill in fields in a dialog
box.

I Y % 10:13 G
Meeting Motes -

I =
Tap to select an input
7| | method or change
ABC T abc " 73] @ options
5 9 | | Tap to show or hide the
. . 2| input panel.
New Edit Tools = | # &la—

The letter you write is
converted to typed text
that appears on the
screen.

e The default Writing mode for Letter Recognizer is the
Lowercase (Jot-compatible) mode. In this mode, you
write characters in lowercase. The chart at the end of this
appendix contains examples of how to write characters in
the Lowercase mode. You can also choose to write in the
Uppercase (Graffiti-compatible) mode.
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In this mode, you write characters in uppercase. Whether
a letter appears in uppercase or lowercase when it is
converted to typed text depends on where in the input
panel you write it, not on the mode you have selected.

The Letter Recognizer input panel is divided into three
writing areas. Letters written in the left area (labeled
ABC) creates uppercase letters, and letters written in the
middle area (labeled abc) creates lowercase letters. Use
the right area (labeled 123) for writing numbers,
symbols, special characters, and punctuation.

Letter Area Humber/Punctuation Area
A QmE, N illy] 3y
B b o 0|0 1 +|+
c|C ¢ bl 2|92 (¥ b
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11 T - |o = |
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M () zlz CiC
space | ~ enter
back back
space space




Appendix A: Letter Recognizer

e The chart is a partial display of the characters you can
write while in the Lowercase mode (the dot on each
character is the starting point for writing). Remember
that even though you write a letter in its lowercase form,
the case of the text that is displayed depends on where
you write the letter. For example, if you write a lowercase
“a” in the ABC area, an uppercase "A” is displayed on the
screen.

For more information on using Letter Recognizer and for
demos of all characters, tap “* on the Letter Recognizer
input panel.
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Appendix B: Troubleshooting

Reset the Pocket PC Phone and clear memory

You can perform a soft reset or a full reset, depending
on the situation: a full reset, in the sense that you will
lose all data and any software you have installed
yourself, is similar to reinstalling your OS on your PC; a
soft reset is similar to restarting your desktop.

If your Pocket PC Phone responds slowly, stops
responding or freezes, try a soft reset. A soft reset
causes the Pocket PC Phone to restart and re-adjust
memory allocation. Unsaved data in open windows may
be lost.

To perform a soft reset:

use the stylus to press and hold the Reset button for
about two seconds. (For details on finding soft reset,
see page XX.

To perform a full reset:

Information required???

Battery loses power

When the battery is low, you can see a battery icon
(@ - main battery low, {_ - main battery very low)
by tapping the time area. A pop-up screen tells you to
recharge the battery as soon as possible. The battery is
split into two portions: the main battery and the backup
battery. When the main battery portion is discharged
your Pocket PC Phone will power off. However, the
backup battery portion will preserve your data for 72
hours. If the backup battery portion is discharged, you
run the risk of losing the data on your Pocket PC Phone.

Y-\
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You want your Pocket PC Phone battery charge to last as
long as possible, especially when you’re on the road.
Under normal conditions, you can get many hours of use
from a single set of batteries or from a full charge. Here
are a few tips to help you get the most from them.

Use external power whenever possible

Use the AC adapter to plug your Pocket PC Phone into
an external power source whenever possible, especially
when:

e establishing a remote connection.

e using the frontlight feature of your Pocket PC Phone
display.

e connecting to a PC.
e |etting the notification light flash for extended periods.

Shorten auto suspend time

While on battery power, your phone automatically
suspends operation if you haven’t touched the hardware
buttons or used the stylus for a specified period.
Maximize battery life by shortening the time. Tap Start
and then Settings. In the System tab, tap Power, and
then adjust the On battery power setting.

To turn off sounds you don’t need:

The Pocket PC Phone produces sounds in response to a
number of events, such as warnings, appointments, and
screen taps or hardware button presses. To optimize
battery life, turn off any sounds you don’t need. Tap
Start and then Settings. In the Personal tab, tap
Sounds & Notifications and clear check boxes on the
Volume and Notifications tabs.
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To turn off notification light:

Tap Start and then Settings. In the Personal tab, tap
Sounds & Notifications. In the Notifications tab,
clear the Flash light for check box.

If you forget your password

If you forget your password, you'll need to clear
memory on the Pocket PC Phone. See Reset the
device and clear memory earlier in this appendix.

If you run out of phone memory

Memory on your Pocket PC Phone is shared between
storage memory and program memory. Storage
memory is used to store the information you create and
programs you install. Program memory is used to run
programs on your Pocket PC Phone.

Pocket PC Phone automatically manages the allocation
between storage and program memory. However, in
some situations, such as when memory is low, the
Pocket PC Phone may not be able to automatically
adjust the allocation. If you receive a message stating
that storage or program memory is unavailable, try the
following solutions.

Finding Space In Storage memory

e Move data to an MMC/ SD storage card.

e From the Start menu, tab Programs — File Explorer.
Tap and hold the file you want to move, and tap Cut.
Browse to the My Documents folder in the storage card
folder, tap Edit, and then tap Paste.

A
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Files stored in folders other than My Documents or
stored in folders within folders in My Documents may
not show up in the list view of some programs. When
using Notes, Pocket Word, or Pocket Excel, you can
also move files by opening the item and tapping Tools or
Edit and then Rename/Move.

Move e-mail attachments. In Inbox, tap Tools and then
Options. In the Storage tab, select Store
attachments on storage card. All attachments are
moved to the storage card, and new attachments are
automatically stored on the storage card.

Set programs such as Notes, Pocket Word, and Pocket
Excel to automatically save new items on the storage
card. In the program, tap Tools and then Options.

If you are copying files from your PC or another device to
your Pocket PC Phone, try adjusting the slider in the
Memory setting. Tap Start and then Settings. In the
System tab, tap Memory and check whether the slider
can be adjusted manually before copying files.

Delete unnecessary files. From the Start menu, tap
Programs — File Explorer. Tap and hold the file, and
then tap Delete on the pop-up menu. To find your larger
files, tap Start and then Find. In the Type list, tap
Larger than 64 KB, and then tap Go.

In Internet Explorer options, delete all files and clear
history. In Internet Explorer, tap Tools and then
Options. Tap Delete Files and Clear History.

Remove programs you no longer use. Tap Start and then
Settings. In the System tab, tap Remove Programs.

Tap the program you want to remove and then Remove.

Clear program memory as described in the following
section. This will free some program memory so that it
can be allocated to storage memory.
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Finding Space In Program Memory

e Stop programs you are not currently using. In most
cases, programs automatically stop to free needed
memory. However, in some situations, such as when
confirmation dialog boxes are waiting for a user
response, the program may not be able to automatically
stop. To check the state of your active programs, tap
Start and then Settings. In the System tab, tap
Memory and then the Running Programs tab. Tap the
program you want to view and then tap Activate. Close
any open windows or messages and return the program
to list view. If this doesn’t work, you can stop the
program manually. First, make sure that closing open
items and returning the program to list view save your
work. Then, stop the program by tapping Stop or Stop
All in the Running Programs tab.

¢ Clear storage memory as described in the preceding
section. This will free some storage memory so that it
can be allocated to program memory.

e Resetting your Pocket PC Phone can release the program
memory. You can do it as described in Reset the Pocket
PC Phone and clear memory earlier in this appendix.

Screen freezes or responds slowly

Reset your Pocket PC Phone. See Reset your Pocket
PC Phone and clear memory earlier in this appendix.

Screen is blank

If your Pocket PC Phone doesn’t respond when you
briefly press the Power button, press and hold the
button for a full second.

A
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If that doesn’t work:

e make sure your SIM door cover is closed and all
expansion slots are secured.

¢ plug the AC power into the device.

e reset the device. See Reset the device and clear
memory earlier in this appendix.

Screen is dark

Prolonged exposure to direct sunlight may cause your
Pocket PC Phone screen to temporarily darken. This is
normal for LCD screens and is not permanent.

Screen is hard to read

If you're having a hard time viewing a document in
Notes, try changing the size of the view. To do this, tap
a zoom percentage on the Tools menu. In Pocket
Word and Pocket Excel, on the View menu, tap Zoom
and then select a zoom percentage. In Internet
Explorer, on the View menu, tap Text Size and then
select a size. If you're having a hard time viewing
Pocket Outlook data, try enlarging the display font. To
do this within Calendar, Tasks, or Contacts, tap Tools,
then Options, and then select Use large font.

Inaccurate response to stylus taps

Adjust the touch screen to respond more accurately to
screen taps. Tap Start and then Settings. In the
System tab, tap Screen — Align Screen.
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Slow or no response

Reset your Pocket PC Phone. See Reset the Pocket PC
Phone and clear memory earlier in this appendix.

Infrared (IR) connection problems

If you are unable to use IR to transfer information, try
the following:

e Transfer only one file or no more than 25 contact cards at
a time.

e Line up the IR ports so that they are unobstructed and
within a close range.

e Make sure nothing is between the two IR ports.

e Adjust the room lighting. Some types of light interfere
with IR connections. Try moving to a different location or
turning off some lights.

Phone connection problems

If you have a problem using your phone, try the
following:

e Check that your wireless connection to your mobile
service provider is switched on and that the signal is
unobstructed (For more information, see Checking you
are Connected.

e Contact your mobile phone service provider for help.

Internet connection problems

The following connection problems may occur. Additional
troubleshooting information is available in Connections
Help on the Pocket PC Phone and ActiveSync Help on
the PC.

A
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e Check that you have set up and are connected to an
Internet service provider.

e Check that your wireless connection to your mobile
service provider is switched on and that the signal is
unobstructed (For more information, see page XX).

e Check Verify with your Internet service provider that your
user name and password are correct.

o Verify with your Internet service provider that the
network you are trying to connect to is available, or try to
connect to it from another PC.

Network connection problems

The following connection problems may occur. Additional
troubleshooting information is available in Connections
Help on the Pocket PC Phone and ActiveSync Help on
the PC.

o Check that your wireless connection to your mobile
service provider is switched on and that the signal is
unobstructed (For more information, see page XX).

Verify that you have added necessary server information.
Tap Start and then Settings. In the Connections tab,
tap Network Adapters. Most networks use DHCP, so
you should not have to change these settings unless your
network administrator instructs you to do so.

If Network Connection isn't listed as a connection
method in the ActiveSync dialog box when starting
synchronization, wait a few minutes and try again. Also,
if synchronization does not start right away, the network
is probably busy, and it may take a minute for your
Pocket PC Phone to connect to the network.
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e Verify with your network administrator that your user
name and password are correct.

e Verify with your network administrator that the network
you are trying to connect to is available, or try to connect
to it from another PC.

¢ You may need to change the device name if you are
trying to connect to a network and cannot because
another Pocket PC Phone with the same name is already
connected. To change the Pocket PC Phone name, tap
Start and then Settings. In the System tab, tap About,
and then the Device ID tab.

Cable and cradle connection problems

The following solutions may help if you encounter
problems when connecting to your PC. Additional
troubleshooting information is available in Connections
Help on the Pocket PC Phone and ActiveSync Help on
the PC.

e Ensure the Pocket PC Phone is turned on.

e Ensure that you do not have any other active
connections. Tap Start and then Today. Tap @5 or 25
at the bottom of the screen and then Disconnect.

e Ensure the cable is securely plugged into the COM port
on the back of your PC. Use the cable that came with the
Pocket PC Phone without any extra cables or extenders
attached.

e Plug the other end of the cable securely into the correct
port on your Pocket PC Phone. If you are using a cradle,
push your Pocket PC Phone securely into the cradle.

A
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Appendix C: Regulatory
Notices

Regulatory Agency Identification Numbers

For regulatory identification purposes your product is
assigned a model number PW10xx.

The following accessories have been evaluated for use
with your Pocket PC Phone. Their assigned model
numbers listed below can identify these approved
accessories. To ensure continued reliable and safe
operation of your Pocket PC Phone, use only the
accessories listed below with your PW10xx.

Accessories Model Number
Pocket PC PW10xx

Phone

Cradle PW15x

External PW16x

Battery Pack

Note:

¢ The above “x” may be any alphanumeric character or blank
denoting external cosmetic changes.

e This product is intended for use with certified Class 2, rated
5V dc, minimum 1A power supply unit.
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European Union Notice

Products with CE marking comply with the R&TTE
Directive (99/5/EC), the EMC Directive (89/336/EEC)
and the Low Voltage Directive (73/23/EEC) issued by
the Commission of the European Community.

Compliance with these directives implies conformity to
the following European Norms (in brackets are the
equivalent international standards):

e EN 60950 (IEC 60950) - Safety of Information
Technology Equipment

e ETS 300 342-1 (June 1997) - Electromagnetic
compatibility and Radio spectrum Matters (ERM);
ElectroMagnetic Compatibility (EMC) for European digital
cellular telecommunications system (GSM 900MHz and
GSM 1900MHz); Part 1: Mobile and portable radio and
ancillary equipment

e GSM11.10

e ANSI/IEEE C.95.1-1992- specific absorption rate in
mobile phone emission condition for body health

e FCC part 15 and part24
e prENV50166-2, 1995 for SAR
SAR: 0.892mW/10g

Important Safety Information

Retain and follow all product safety and operating
instructions. Observe all warnings on the product and in
the operating instructions.

To reduce the risk of bodily injury, electric shock, fire,
and/or damage to the equipment observe the following

precautions.



FCC RF EXPOSURE INFORMATION

In August 1996 the Federal Communications Commission (FCC) of
the United States with its action in Report and Order FCC 96-326
adopted an updated safety standard for human exposure to radio
frequency electromagnetic energy emitted by FCC regulated
transmitters. Those guidelines are consistent with the safety
standards previously set by both U.S. and international standards
bodies. The design of this phone complies with the FCC guidelines
and these international standards.

Use only the supplied antenna or one that is approved.
Unauthorized antennas, modifications, or attachments could impair
call quality, damage the phone, or result in a violation of FCC
regulations.

Do not use the phone with a damaged antenna. If a damaged
antenna comes into contact with the skin, a minor burn may result.
Please contact your local dealer for a replacement antenna.

Body-worn Operation

This device was tested for typical body-worn operations with the back

of the phone kept 1.5 cm. from the body. To maintain compliance

with FCC RF exposure requirements, use only belt-clips, holsters

or similar accessories that maintain at least a 0.59 inch (1.5 cm.) separation
distance, between the user's body and the back of the phone, including

the antenna. The use of belt-clips, holsters and similar accessories should
not contain metallic components in its assembly. The use of accessories
that do not satisfy these requirements may not comply with FCC RF
exposure requirements, and should be avoided.

Vehicle Mounted External Antenna (optional, if
available.)
A minimum separation distance of 7.9 inches (20cm) must be

maintained between a person and the vehicle mounted external
antenna to satisfy FCC RF exposure requirements.

For more information about RF exposure, please visit the FCC web
site at www.fcc.gov
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General Precautions

Heed service markings: Except as explained elsewhere
in the Operating or Service documentation, do not
service any product yourself. Service needed on
components inside these compartments should be done
by an authorized service technician or provider.

Damage requiring service: Unplug the product from
the electrical outlet and refer servicing to an authorized
service technician or provider under the following
conditions:

e Liquid has been spilled or an object has fallen into the
product.

e The product has been exposed to rain or water.
e The product has been dropped or damaged.
e There are noticeable signs of overheating.

e The product does not operate normally when you follow
the operating instructions.

Avoid hot areas: The product should be placed away
from heat sources such as radiators, heat registers,
stoves, or other products (including amplifiers) that
produce heat.

Avoid wet areas: Never use the product in a wet
location.

Avoid pushing objects into product: Never push
objects of any kind into cabinet slots or other openings
in the product. Slots and openings are provided for
ventilation. These openings must not be blocked or
covered.
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Mounting Accessories: Do not use the product on an
unstable table, cart, stand, tripod, or bracket. Any
mounting of the product should follow the
manufacturer’s instructions, and should use a mounting
accessory recommended by the manufacturer.

Avoid unstable mounting: Do not place the product
with an unstable base.

Use product with approved equipment: This product
should be used only with personal computers and
options identified as suitable for use with your
equipment.

Adjust the volume: Turn down the volume before using
headphones or other audio devices.

Cleaning: Unplug the product from the wall outlet
before cleaning. Do not use liquid cleaners or aerosol
cleaners. Use a damp cloth for cleaning, but NEVER use
water to clean an LCD screen.

Safety Precautions for Power Supply Unit

Use the correct external power source: A product should
be operated only from the type of power source
indicated on the electrical ratings label. If you are not
sure of the type of power source required, consult your
authorized service provider or local power company. For
a product that operates from battery power or other
sources, refer to the operating instructions that are
included with the product. Handle battery packs
carefully: This product contains a Lithium Polymer
battery.
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There is a risk of fire and burns if the battery pack is
handled improperly. Do not attempt to open or service
the battery pack. Do not disassemble, crush, puncture,
short external contacts or circuits, dispose of in fire or
water, or expose a battery pack to temperatures of
higher than 60°C (140°F).

Note: Danger of explosion if battery is incorrectly replaced.
Replace only with specified batteries. Dispose of used
batteries according to the local regulations or reference
guide supplied with your product.

Appendix D: Hardware Specifications

Appendix D: Hardware Speci-

fications

Information is required!!!





